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Foreword 

EuroScope, a controller client developed by Gergely Csernák for the VATSIM network, was first released for 

public use in September 2007. One of the biggest changes in version 3.1 was the possibility for the user 

community to customize the program to an even higher degree than was possible before by writing their 

own plugins that can be used to alter the way information is presented and even create completely new 

functionality into the program. This allowed creating very detailed simulations of all kinds of ATC systems 

without making the main program overly complex. Version 3.2 expands on these possibilities, making it 

possible to create even better plugins. 

The TopSky plugin (a.k.a. The Plugin Formerly Known As “EUROCAT 2000 E”) started out as a very small 

project to create a couple of customized aircraft tag items, but as more information about the real system 

and the possibilities with the plugin development became available, it slowly grew to include an almost 

complete set of tag items, tag menus, graphical elements on the radar display and some additional 

functionality. 

Although - as its name suggests - the plugin is based on the TopSky ATM system, it is in no way affiliated 

with or endorsed by Thales Group. Similarities between plugin features and the real system are not entirely 

coincidental, but anyone planning to use the plugin as a real-world training aid really should know better… 

This manual is based on the reader having at least a basic understanding of ATC procedures and 

terminology, and being familiar with the operation of the EuroScope program itself. Refer to the EuroScope 

documentation for the most current information on the program’s features. Because of the complexity of 

the plugin, some offline practice is recommended before attempting to control online traffic with it. 

Have fun!
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1 Acknowledgements 
This plugin contains code and/or ideas from the following sources: 

- The RDF feature is based on Claus Hemberg Jørgensen’s work on his RDF plugin 

- File transfers use the libcurl library 

- JSON parsing uses the JSON for Modern C++ library 

- Weather radar images are parsed using the libpng and zlib libraries 

- GRIB2 data is parsed using the NCEPLIBS-g2c library 

2 Getting started 

The plugin requires the MSVC++ Redistributable package to be installed. Without it, the plugin will either 

fail to load at all, or crash while trying to load. 

The plugin is usually included in a package that includes a set of compatible settings files for its operation. 

They usually contain everything that is needed to use the plugin except complete profile files since they 

contain information that is system and user specific. Starting to use the plugin is then just a matter of 

completing the necessary profile files by editing an existing file or starting from the one contained in the 

package and adding the user specific data in EuroScope. 

The most obvious sign of successfully loading the plugin is that the Global Menu is drawn on the top edge 

of the radar screen. 

The plugin has two main setups that differ from each other in so many ways that they have their own 

General parts of the manual set. This document describes the features in the COOPANS setup, activated 

by entering “COOPANS=1” in the plugin’s settings file. The easiest way to determine which one you have 

set up is to check what the Global Menu looks like. If it’s not the same as the image in this document, 

you’re looking at the wrong manual. 

This document explains the general features of the plugin. The Developer Guide includes information to 

people interested in either developing data files for the plugin or changing some of the plugin settings. In 

addition, there are a number of other documents providing information about specific features 

(coordination, datalink functionality), documents detailing the local setup may be provided as well. 

In case the plugin wasn’t part of a package, there are problems with the settings files or you want to create 

your own setup, refer to the Developer Guide part of the manual set. It details the settings that are 

required in EuroScope to use the plugin the way it is supposed to. 

Some features of the plugin require data files to be prepared to enable their functionality. None of them 

are mandatory for basic plugin operation but if used they must be in the same folder as the plugin itself. 

The file names must be exactly as specified. For more information see the Developer Guide. 

On startup, the plugin will attempt to check for updates. If the check fails or a new version is available, a 

message box will be presented. In case a mandatory update exists and the latest date to update has already 

passed, the plugin features will be blocked until it is updated. When an update is available, the message 

box will include a link to the current version, but the primary way to update the plugin should always be the 

original download location, as it is the only way to keep the other files in the package up to date as well.  

https://github.com/chembergj/RDF
https://curl.haxx.se/libcurl/
https://github.com/nlohmann/json
http://www.libpng.org/
https://zlib.net/
https://github.com/NOAA-EMC/NCEPLIBS-g2c
https://aka.ms/vs/17/release/vc_redist.x86.exe
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3 Performance considerations 
Due to its complexity, the plugin can at times require a lot of resources. The performance cost depends on 

graphical items (what’s drawn on the screen) and background calculations for various plugin systems. 

Generally speaking, the background calculations become more of an issue with increase in traffic while the 

effect of graphical items depends only on the number and complexity of items drawn. 

While the actual impact depends on the hardware and the situation, here are some suggestions for actions 

that can be used to reduce the effect if the performance starts to become an issue. Many plugin settings 

can have a significant effect on performance, but this chapter only lists actions that can be done during a 

session without having to edit any settings data files. 

3.1 Graphical items 
The following may help to increase the refresh rate when panning and zooming the screen: 

- Active areas and maps Display only what’s necessary, define large drawings in the   

    sector file when possible to let EuroScope draw them 

- Weather Map  Set display off 

- Brightness Window  Set “ASD background” to 100% 

The following may help with performance issues generally: 

- Radar screen area  Adjust zoom level to display only the necessary area 

- FPASD display  Set off or apply filter in Setup->Local Settings 

- Raw Video  Set off 

- Track history dots number Reduce 

- Track prediction line length Reduce 

- Plugin windows  Close unnecessary ones 

The effect of using track filters depends on the proportion of tracks that would be filtered. If many tracks 

are filtered out, there is some performance gain for not having to draw their track labels, but in cases 

where only a small number of tracks are filtered, the active filters may actually decrease the performance 

due to the filtering code being run. 

3.2 Background calculations 
The calculations required for the FPCP functions increase rapidly with increasing traffic, so adjusting some 

of the following may help (in this order): 

- Check “Unco” and “Notif” are deselected in the CARD View menu unless required 

- Reduce the FPCP inhibit time in Setup -> Local Settings 

- Turn the whole MTCD system off (MTCD Status Window) 

The TCT and Blind Spot functions have a similar increase in calculations, although with a smaller look-

ahead-time, their effect is slightly smaller. To recover performance, the following may help (in this order): 

- Turn the TCT system off (Safety Nets Status Window) 

- Turn the BS system off (Safety Nets Status Window) 

(Even with TCT turned off, some of its calculations are still being run if BS is enabled) 
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The effect of increasing traffic to the STCA, MSAW, APW functions is not as steep, but still significant. The 

following may be used to reduce it: 

- Adjust STCA alert settings in Setup -> Local Settings ( All > Own+Co > Own ) 

- Turn the whole system(s) off (Safety Nets Status Window) 
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4 Global Menu 

 

The Global Menu is located on the top edge of the radar screen. It displays the current UTC time (left-

clicking opens the Clock Window) and contains a number of submenus which are explained below. 

4.1 Setup menu 
- Direction Finder >       (1) Opens the Direction Finder submenu  

- Weather Map > Opens the Weather Map submenu 

- Unit Settings > Opens the Unit Settings submenu 

- Default Setting  Resets all settings to their default values 

- Local Settings > Opens the Local Settings submenu 

- Brightness Control…  Opens the Brightness Control Window 

- Sign In…          (2) Loads personal settings (usually done automatically) 

- Sign Out…  Clears any personal settings and resets all settings to their default values 

- Raw Video Control…          (3) Opens the Raw Video Control Window 

- [] Raw Video          (3) Toggles on/off the display of raw video radar plots 

- AMID  > Not implemented 

- CFL  > Opens the CFL submenu 

- Flight Leg > Opens the Flight Leg submenu 

- [] FPASD  Toggles on/off the display of flight plan tracks 

- CPDLC Setting…  Opens the CPDLC Setting Window 

- RR Main >       (4) Opens the RR Main submenu 

- [] FAST          (5) Toggles on/off the FAST function 

- [] Blind Spot          (6) Toggles on/off the Blind Spot function 

 

1) Not shown if the DF system has been disabled in the plugin settings 

2) Personal plugin settings can be defined in a data file (see the Developer Guide) 

3) Not shown unless at least one radar station has been defined. The raw radar video plots are from a 

specified radar station. The specification is done in a data file (see the Developer Guide) and the 

radar selection is based on the login callsign. 

4) Not shown if the range rings function has been disabled in the plugin settings 

5) Not shown if there are no FAST approaches defined 

6) Not shown if the Blind Spot function has been disabled in the plugin settings 

4.1.1 Direction Finder submenu 

- DF Selection…  Not implemented 

- DF Length > Opens a DF length selection submenu to select one of four 

    pre-defined lengths for the DF line (available only when the 

    “bearing line” DF type is set up) 

The DF system, when activated (via the Radar Menu), draws either: 

- A bearing line from a pre-defined DF antenna location (if specified in the plugin settings) 

or 
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- A circle on the radar screen identifying the location of the transmitting aircraft. If the location is off-

screen, a line will be drawn from the center of the screen towards the actual location. 

4.1.2 Weather Map submenu 

- Display Toggles the weather radar image on/off 

- Brightness Adjusts the image brightness (1-100%) 

- Gain  Adjusts the image gain level (1-999%) 

The weather data is filtered to display two levels of precipitation (its reflectivity factor to be more exact) 

with the default threshold values aligned with aircraft weather radars. The lighter shade is for >=30dBZ 

(yellow on aircraft displays) and the darker shade >=40dBZ (red). The image is refreshed every 10 minutes. 

The data is only available when a position to center the image on has been entered in the settings data file. 

It is possible to configure a third level using the settings files. 

The gain control is very sensitive especially when reducing it. When using the default reflectivity threshold 

settings, even the strongest possible echo disappears below 40% gain and at gain levels above 700% all 

possible echoes are displayed with the darkest shade. 

4.1.3 Unit Settings submenu 

This submenu can be used to change the units used in the plugin. Any changes to the settings are session-

specific only, so they will be lost when exiting EuroScope. 

- Altitude Selects the units used for altitudes and vertical rates 

▪ Nautical (feet, feet per minute) 

▪ Metric (meters, meters per second) 

- Flight level Selects the units for flight levels – only applicable with metric altitudes 

▪ Nautical (hundreds of feet) 

▪ Metric (meters) 

- Distance Selects the units used for distances 

▪ Nautical (nautical miles) 

▪ Metric (kilometers) 

- Speed  Selects the units used for speeds 

▪ Nautical (knots) 

▪ Metric (kilometers per hour) 

4.1.4 Local Settings submenu 

This submenu allows changing some of the plugin’s settings. Any changes to the settings are session-

specific only, so they will be lost when exiting EuroScope. 

- Vertical reference  Selects the pressure reference to be used at or below the 

transition altitude: 

• QNH Altitude above mean sea level 

• QFE Height above the aerodrome elevation 

(set/check it in the adjacent box) 

- Used equipment codes Selects whether to use or disregard the equipment codes 

found in the flight plans: 

• All Use codes in both ICAO and FAA formats 
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• ICAO Use codes when specified in ICAO format 

• FAA Use codes when specified in FAA format 

• None Disregard all codes 

-    Selects specific capabilities to be taken into account: 

• R RNAV capability 

• PBN PBN string from FPL remarks 

• W RVSM capability 

• Y 8.33 kHz capability 

• AltRptg Transponder altitude reporting capability 

• Mode S Transponder mode S capability 

• EHS Mode S enhanced surveillance capability 

• FLTID Mode S flight ID downlink capability 

When taking into account a specific capability is deselected, all aircraft are assumed to have it. This inhibits 

track label alerts and also affects safety net processing. 

- ASSR codes  Selects the transponder code source: 

• Plugin Plugin data file (reverts to ESE if no codes found) 

• ESE ESE file 

• Range Fixed code range 

- Groundspeed  Selects whether to use pilot client reported ground speed or a 

plugin calculated value. Normally the reported value should be 

used as it is more accurate and stable, but some clients report 

wrong values. If that causes problems, you can try selecting the 

plugin calculated value instead 

- Transfer confirmation Selects when to display the Transfer Confirmation Window: 

• On Always when CFL is not equal to XFL 

• NotRFL When CFL is not equal to XFL unless XFL = RFL 

• Off Never, any CFL value is OK 

- CFL menu default value Selects the default value for the CFL menu when it is opened: 

• Auto FSS or CTR: RFL if not yet reached, otherwise as below 
  Other: The XFL value, or current CFL value – 1000ft with no XFL 

• CFL The current CFL value 

• RFL The RFL value 

- FPCP inhibit  FPCP calculations start when tracks are within this time from 

    entering active sector 

- STCA alert  Selects which aircraft display the STCA alert: 

• All All aircraft 

• Own+Co Only assumed and coordinated aircraft 

• Own Only assumed aircraft 

- STCA alert sound  Selects which STCA alerts trigger the alert sound: 

• All All alerts 

• Own+Co Only alerts for assumed or coordinated aircraft 

• Own Only alerts with assumed aircraft 

• Off No alert sound 
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- APW alert  Selects which aircraft display the APW alert: 

• All All aircraft 

• Own+Co Only assumed and coordinated aircraft 

• Own Only assumed aircraft 

- APW alert sound  Selects which STCA alerts trigger the alert sound: 

• All All alerts 

• Own+Co Only alerts for assumed or coordinated aircraft 

• Own Only alerts for assumed aircraft 

• Off No alert sound 

- METAR source  Selects the METAR data source for the plugin windows that 

display METAR data 

- FPASD filter  Allows filtering of displayed FPASD tracks based on sector state 

• Coord Display tracks at least in the coordinated state 

• Conc Display tracks at least in the concerned state 

• None Display all tracks 

4.1.5 CFL submenu 

- Reduced  The reduced length CFL menu is used 

- Extended  The extended length CFL menu is used 

4.1.6 Flight Leg submenu 

- Assumed  Automatically displays Flight Leg when track is assumed 

- Potential Predicted  Displays potential predicted conflicts on flight leg 

- Potential Risk  Displays potential risks of conflicts on flight leg 

4.1.7 RR Main submenu 

- [] Rings On/Off  Toggles the range rings on/off 

- Point   Sets the rings centerpoint 

- Separation  Sets the separation between adjacent rings 

- Number  Sets the number of rings drawn 

- [] Highlight  Toggles highlight (drawn with solid line) of specified rings 

- Step   Sets interval of highlighted rings 

The rings centerpoint can be set either by clicking on the radar screen or entering the desired point in the 

text field. Fixes, VORs, NDBs and airports from the active sector file can be used as well as coordinates in 

the flight plan format (DD[N/S]DDD[E/W] or DDMM[N/S]DDDMM[E/W], e.g. 60N025E or 0811S00300W). 

Entering an empty text string resets the rings to be shown at the radar screen centerpoint. 

4.2 AMS menu 
- TSA…   Opens the Airspace Management Window 

- NAT  > Opens the NAT submenu (shown only on oceanic setups) 

4.2.1 NAT submenu 

- Eastbound Map  Toggles display of eastbound tracks map 

- Westbound Map  Toggles display of westbound tracks map 

- NAT List…  Opens the NAT List Window 
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Opening the NAT submenu triggers downloading the NAT Track Message which is then updated hourly. The 

tracks extracted from the messages can be displayed on the radar screen. Any named waypoints in the 

tracks that cannot be found in the active sector file are just skipped so the displayed tracks may not be 

accurate. 

 

4.3 FData menu 
- Flight Plan Selection… Opens the Flight Plan Selection Window 

- Flight Plan Window…  Opens the Flight Plan Window 

4.4 Tools menu 
- Flight Plan Lists  > Opens the Flight Plan Lists submenu 

- CARD…  Opens the Conflict And Risk Display 

- SAP…   Opens the Segregated Area Probe Window 

- Message In…  Opens the Message In Window 

- Message Out…  Opens the Message Out Window 

- Shortcut…  Opens the Shortcut Window 

- CPDLC >  Opens the CPDLC submenu 

4.4.1 Flight Plan Lists submenu 

- [] List options bar (1) Toggles the display of list options on the Global Menu 

- SIL… 

o Sort (2) Selects sorting option 

- Sector List…  Opens the Sector List 

o Sort (2) Selects sorting option 

o [] Informed  Toggles the display of informed aircraft  

o [] Concerned  Toggles the display of concerned aircraft 

o [] Redundant  Toggles the display of redundant aircraft 

- Load Factor List…  Opens the Load Factor List 

o Sort (2) Selects sorting option 

- Departure List… 

o Sort (2) Selects sorting option 

- Resectorisation List…  Opens the Resectorisation List 

o Sort (2) Selects sorting option 

o LFUNC (3) Resectorisation List LFUNC filter 

- ETWR List…  Opens the ETWR List 

o Sort (2) Selects sorting option 

o ADEP (3) ETWR List departure airports filter 

- Uncont. List 1…  Opens the Uncontrolled List 1 

o Sort (2) Selects sorting option 

o Display (4) Uncontrolled List 1 state filter 

o Filter (5) Uncontrolled List 1 units filter 

- Uncont. List 2…  Opens the Uncontrolled List 2 

o Sort (2) Selects sorting option 

o Display (4) Uncontrolled List 2 state filter 
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o Filter (5) Uncontrolled List 2 units filter 

- Lost List…  Opens the Lost List 

- Traffic Mgt. List 1…  Opens the Traffic Management List 1 

o Sort (2) Selects sorting option 

o Display (6) Traffic Management List 1 flight plan state filter 

o ADES (3) Traffic Management List 1 destination airports filter 

o Via (3) Traffic Management List 1 route points filter 

- Traffic Mgt. List 2…  Opens the Traffic Management List 2 

o Sort (2) Selects sorting option 

o Display (6) Traffic Management List 2 flight plan state filter 

o ADES (3) Traffic Management List 2 destination airports filter 

o Via (3) Traffic Management List 2 route points filter 

Note 1 : When enabled, the list options bar displays “Info Conc Redu Filter Filter” on the right edge of the 

Global Menu. The first three toggle the respective settings for the Sector List and are colored with 

the appropriate color when enabled, and the last two are displayed in “Redundant” color when the 

corresponding Uncontrolled list is somehow filtered. Clicking on them opens the Flight Plan Lists 

submenu to change the filtering options. 

Note 2 : Left- or right-clicking the Sort option cycles through the options forward and backward in 

alphabetical order. This sorting is achieved using a special sorting tag item in the lists that is hidden 

from view (in the example list setups provided with the plugin, it’s the first item, named “SortItem”). 

The sorting only works when the list is sorted according to that item. If the list is sorted according to 

any other item, this sorting choice will have no effect until the list is again sorted according to the 

special sorting item (by displaying it in the list, clicking on the column title, and then hiding it again). 

Note 3 : Left-clicking the “LFUNC”, “ADEP”, “ADES” and “Via” boxes open text entry boxes to enter comma-

separated lists for controlled ID’s, ICAO codes and point names respectively to filter the affected 

lists. 

Note 4 : Left-clicking the Display option cycles through “ALL” (no filtering), “ON-CONTACT” (only tracks on-

contact with anyone), “ON-CONTACT-PPOS” (only tracks on-contact with you) and “FREE” (only 

tracks in the free state). 

Note 5 : Left-clicking the Filter box opens a text entry box to enter a comma-separated list of aerodrome 

ICAO codes to filter the list. When entered, the list will display a flight only if one of the entered 

codes is its departure or destination, or the code is found in its scratchpad (OP-TEXT2). 

Note 6 : Left-clicking the Display option toggles between “ALL” (no filtering), “SIMUL+TERM” (not started 

flight plans filtered), “NOTST+SIMUL” (terminated flight plans filtered) and “SIMUL” (not started 

and terminated flight plans filtered). 

4.4.2 CPDLC submenu 

- Microphone Check  Opens the Microphone Check menu 

- Current Messages…  Opens the CPDLC Current Message Window 

- History Messages…  Opens the CPDLC History Message Window 
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4.5 MET menu 
- Messages…  Opens the Weather Messages Window 

- Upper Winds…  Opens the Upper Winds Window 

- Airfield Data…  Opens the Airfield Data Window  

4.6 [x] (number in square brackets) 
Shows the number of received SIGMET messages. The number is limited to 99, and is shown on “Global 

Menu Highlight” background when not zero and the Weather Messages Window is not open. Left-clicking 

the number will open the Weather Messages Window with the SIGMET option selected. 

4.7 Info menu 
- General Information… Opens the General Information Window 

- MISC Information…  Opens the Miscellaneous Information Window 

- NOTAM…  Opens the NOTAM List Window 

- Small QNH/TL…  Opens the Small QNH/TL Window 

- LFUNC Frequency…  Opens the LFUNC Frequency Plan Window 

- [] Airport labels  Toggles airport labels selection 

- [] Fix labels  Toggles fix labels selection 

- [] NDB labels  Toggles NDB labels selection 

- [] VOR labels  Toggles VOR labels selection 

When holding a specified key down (<ALT> by default), text labels will be displayed for airports, fixes, NDBs 

and VORs when the mouse cursor is placed over them. When one or more of the categories in the Info 

menu is selected, only those categories will display the labels. The “Label” buttons open submenus to select 

what information is shown on the corresponding labels. All the information is from the active sector file. 

The plugin can also be configured so that the “key-down” method is disabled. In that case the labels will be 

shown on mouse-over for categories that have been selected on, and as a reminder the “Info” menu item 

has its background shown in “Global Menu Highlight” color whenever at least one category is selected on. 

4.8 MSG menu 
- Notepad…  Opens a new Notepad Window for text entry 

- Personal Queue…  Opens the Personal Queue Window 

- ATC Messages…  Opens the ATC Messages Window 

- Prim Freq Messages… Opens the Primary Frequency Messages Window 

- Text notes  > Opens the Text notes submenu 

4.8.1 Text notes submenu 

- Create…  Creates a new text note 

- Delete…  Deletes a single text note 

- Delete all  Deletes all text notes 

It is possible to insert text notes on the radar screen to act as reminders. They will stay fixed at the 

geographical coordinates they are inserted to, the coordinates defining the center point of the note. 

When creating a note, a text entry field opens to enter the note text. When the [Enter] key is pressed, the 

note will be created at the current mouse cursor position. 
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The notes can be deleted one by one or all of them at the same time. When deleting one by one, the notes 

are boxed to display their click areas. Clicking on one will delete the note. Pressing the [Esc] key or selecting 

the “Delete…” menu item again will abort the operation. 

4.9 [x] (number in square brackets) 
Shows the number of high priority messages in the personal message queue. These are critical failures in 

the plugin code. Open the Personal Queue Window to view the messages. The number is limited to 99, and 

is shown on “Global Menu Highlight” background when not zero and the window is not open. 

Left-clicking the number opens the Personal Queue Window. 

4.10 [x] (number in square brackets) 
Shows the number of low priority messages in the personal message queue. These are warnings about 

invalid data in the plugin data files. Open the Personal Queue Window to view the messages or see the 

Plugin Status submenu for more detailed information on the problem(s). The number is limited to 99, and is 

shown on “Global Menu Highlight” background when not zero and the window is not open. 

Left-clicking the number opens the Personal Queue Window. 

4.11 STS menu 
- Plugin Status  > Opens the Plugin Status submenu 

- Safety Nets and TCT Status… Opens the Safety Nets Status Window 

- TCT Status…  Opens the TCT Status Window 

- Divergence Detection Status… Opens the Divergence Detection Status Window 

- MTCD Status…  Opens the MTCD Status Window 

- FPCA Status…  Opens the FPCA Status Window 

- CPDLC Default Status [ON/OFF] Toggles the CPDLC Default Status On/Off 

- FAST Configuration…  Opens the Aerodrome menu (to open the FAST Configuration Window)  

- Runway In Use  Opens the Aerodrome menu (to open the Runway In Use Window) 

- Runway Line Display… Opens the Aerodrome menu (to open the Runway Approach Line Window) 

- Supervisory  > Opens the Supervisory submenu 

- Flow Management…  Opens the Air Traffic Flow Management Window 

- Current Operational Load… Opens the Current Operational Load Window 

- Operational Load Forecast… Opens the Operational Load Forecast Window 

4.11.1 Plugin Status submenu 

Shows the version of the plugin as well as some information on the loaded data files. Each data file reports 

its state with one of the following indicators: 

- OK   File contains usable information and no faults 

- NO DATA  File not found or contains no usable information 

- BAD DATA  File contains invalid data (in “Warning” color) 

Depending on the file, there are one to three of the following buttons available: 

- Reload  Reloads the data file 

- View   Displays the data in the file on the radar display 

- Save (Areas)  Saves a snapshot of the current area activation data 
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- Save set (Maps & MapsL) Saves a list of currently active radar screen specific maps 

- Load set (Maps & MapsL) Loads a saved list of active screen specific maps 

For the Areas data file, the displayed area types can be filtered by right-clicking the  View  button, which 

then cycles the displayed areas in the following order (and displays the filter in the button label): 

- TSA   All TSA area types (yellow) 

- MTCD   MTCD areas (green) and inhibit areas (red) 

- STCA   STCA areas (green) and inhibit areas (red) 

- TCT   TCT areas (green) and inhibit areas (red) 

- DD   CLAM/RAM inhibit areas (red) 

Left-clicking the  Save  button will save the currently set manual activation periods as well as the 

information if an area with automatic schedules is set to manual mode. The information is saved to the 

“TopSkyAreasManualAct.txt” file in the same folder as the plugin dll. If the file already exists, the plugin will 

ask for confirmation as the save operation will overwrite any existing data. 

Depending on the maps data file setup, the display state of some or all of the maps may be specific to each 

radar screen. The  Save set  and  Load set  functions can be used to transfer the display state of these maps 

from one radar screen to another. 

Right-clicking the  Reload  button for Settings & SettingsL has a special purpose. It opens a text entry box to 

type in a callsign whose settings should be loaded instead of the real login callsign. When entered, the 

callsign will be displayed next to the “Reload” button, and whenever a VATSIM callsign change is detected, 

an information popup is displayed to remind that the plugin settings are still forced to the manually 

entered callsign. This feature can be used for example to use settings for different positions on different 

EuroScope instances when providing top-down services, or to use settings for a specific position when 

logged in with an observer/staff/supervisor callsign. Clearing the entered callsign reverts to using the 

settings based on the actual login callsign. 

4.11.2 Supervisory submenu 

- Operations Rate…  Opens a new Operations Rate Window 

- Predicted Traffic…  Opens a new Predicted Traffic Window 

4.12 RRx 
Opens the Range Rings menu (see RR Main submenu). If the rings are selected on, “x” displays the distance 

between consecutive rings, otherwise “Off”. If the range rings function has been disabled in the plugin 

settings, this item is not displayed in the Global menu. 

4.13 Mxxx-yyy 
Displays the status of the altitude filters for the Main Radar Window. If enabled and Quick Look is not 

toggled on, the color of the text is “Global Menu Highlight”. “xxx” displays the Lower filter value and “yyy” 

the Upper filter value, in hundreds of feet. 

If metric units are selected for flight levels and/or altitudes, the displayed values will be shown accordingly 

in meters or tens of meters depending on the setup, rounded to the nearest ten meters. 

Left-clicking the item opens the Altitude Filtering Window.  
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5 Air Situation Display 

5.1 Track presentation 
The presentation of tracks consists of the following elements: 

- Aircraft position symbol 

- History dots 

- Prediction line 

- Track label, joined to the position symbol with a leader line 

 

5.1.1 Colors 

Most of the track presentation coloring depends on the flight sector state. 

For  controlled  flights (any IFR flight or a VFR flight in ASSUMED state), the colors are as follows: 

State  Color  Condition 

- Unconcerned “Unconcerned” Track will not enter the active sector 

- Notified “Concerned”  Track will enter the active sector (> 15 min) 

- Coordinated “Coordination” Track will enter the active sector (< 15 min) 

- Assumed “Assumed”  Track is assumed 

- Transfer Initiated “Assumed”  Track is being transferred to the next controller 

- Redundant “Redundant”  Track has been transferred to the next controller  

but is still inside the active sector 

An unconcerned track can be highlighted based on rules (a combination of departure airport, route and 

arrival airport) defined in plugin data files. In this case it is drawn with one of the three “Informed” colors. 

Coordinated tracks that have not departed yet will be shown as notified instead. 

For  uncontrolled  flights (VFR flights not in ASSUMED state), the colors are as follows: 

State  Color  Condition 

- On Contact PPOS “Assumed”  Track is on-contact (a plugin custom state) with you 

- On Contact “Unconcerned” Track is on-contact with someone else 

- Free  “Unconcerned”/“VFR” Track is not on-contact with anyone 

The ”VFR” color is used for positions defined as Flight Information Center positions in the plugin setup. 
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5.1.2 Aircraft position symbol 

The position symbol is drawn at the latest known position of the aircraft. The color of the symbol is the 

flight sector color for an unselected track and “Track Highlight” for a selected one. A number of different 

symbols are available. For the first four rows, the two symbols are the normal symbol on the left and the 

divergence alert (RAM or CLAM) symbol on the right. 

Surveillance tracks 

  
Primary radar track 

  
ADS-B only track 

  
Secondary or combined track without valid DAPs 

  
Secondary or combined track with at least one valid DAP 

 
Track with SPI (transponder ident) 

 
Uncontrolled track 

 
Coasted track (no position updates in over 30 seconds, position no longer reliable) 

Flight plan tracks (position is not based on surveillance data but calculated by EuroScope) 

 
Controlled track 

 
Uncontrolled track 

5.1.3 History dots 

The history dots show the previous positions of the track. The number of displayed dots can be changed via 

the Track Control Window. The color of the dots is the flight sector color for an unselected track and “Track 

Highlight” for a selected one. History dots are not displayed for flight plan tracks. 

5.1.4 Prediction line 

The prediction line draws the predicted ground track of the aircraft, based on its current track and ground 

speed. It is a two-color line, starting with “Track Default” at the position symbol and then alternating with 

“Track Highlight”, with every segment representing one minute of flying time. 

The length of the prediction line can be changed for all tracks via the Track Control Window, or for a single 

track via the Prediction Line menu. The example below shows a selected track with 5 history dots and a 3-

minute prediction line. 
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5.1.5 Track label 

There are four types of track labels that can be displayed: Standard, Reduced, Extended and Uncorrelated. 

In addition, each label except the extended one has an unselected and a selected state, the selected state 

being shown when the mouse cursor is over the label. 

The Reduced label is shown for uncontrolled, unconcerned and notified tracks, the Standard label for other 

tracks. The Extended label can be opened from the Standard or Reduced label and stays open as long as the 

cursor is within the label area. The Uncorrelated label is shown for radar tracks that aren’t correlated with a 

flight plan. 

The unselected Standard and Reduced labels can be minimized to display only some of their contents 

(requires specific plugin setup to define which label fields to display). When a label is minimized, the 

Callsign item is prefixed with a “<” to serve as a reminder. 

Refer to your setup specific documentation for detailed descriptions of the track labels. 
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5.2 Radar picture tools 

5.2.1 Flight Leg 

The Flight Leg displays the aircraft’s planned track in one-minute steps. Each one-minute-long part of the 

path is colored according to the results of the MTCD and SAP processing. The following colors are possible: 

- “Urgency FL” MTCD conflict or potential predicted conflict, SAP conflict 

- “Warning FL” MTCD risk, SAP risk 

- “Potential FL” MTCD potential risk 

- “Conflict Ack FL” MTCD acknowledged conflict (optional feature) 

- “Information FL” MTCD and/or SAP processing available, no conflicts or risks detected 

- “Flight Leg” No MTCD or SAP processing available for this part of the Flight Leg 

If the aircraft has an assigned heading or is not following its route, the predictions only go up to 10 minutes 

and assume the aircraft continues on its present ground track. In this case the predicted track is shown as a 

dashed line when the flight leg is displayed. 

The Flight Leg is displayed by clicking on various track label and list items depending on the setup and is 

either automatically removed from display when the mouse cursor leaves the label area or must be 

manually toggled off, depending on the function that was used to display it. 

The Flight Leg line is one pixel thick, except when it is showing only SAP conflicts (opened from the SAP 

Window) or showing also MTCD information (any conflicting aircraft legs). In that case the FLEG for the 

referenced flight is three pixels thick and the other FLEGs one pixel thick. 

The label that’s shown on each route point can include the following pre-defined fields. 

- ETO  Estimated Time Over the point 

- NAME  Name of the point 

- DIST  Distance from the current track position to the point 

- RFL  Requested Flight Level from that point, if there’s a change (in “Warning” color) 

- SCFL  System Computed Flight Level (EuroScope calculated profile level, prefixed with “*”) 

The Flight Leg displays symbols at the following calculated profile points: 

- Top of climb (an upward pointing triangle, colored “System Calculated TOC”) 

- Top of descent (a downward pointing triangle, colored “System Calculated TOD”) 

5.2.2 Tactical Controller Tool (TCT) Leg 

The TCT leg displays the predicted trajectories of the selected aircraft and the conflicting aircraft up to the 

closest point of approach. If the selected aircraft is involved in more than one conflict, the displayed one for 

the selected aircraft is the conflict where the time to start of conflict is the least. 

The leg is “TCT Leg” color until the start of the conflict, and then “TCT Leg Embellished” until the closest 

point of approach. On the conflicting aircraft’s leg, a label is displayed in “TCT Label” color. It can be set up 

in a number of ways, but by default it displays the minimum distance and time to that point (closest point 

of approach). 
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When TCT legs are being displayed, all minimum separation tools (except for tracks with STCA alert), 

velocity vectors (except for tracks with STCA alert) and flight legs are temporarily hidden. 

5.2.3 AHDG vector 

The AHDG vector is a way of setting an assigned heading for an aircraft. To use the vector, left-click on the 

radar position symbol of the aircraft. This will start drawing the vector. When you’re satisfied with the 

heading value, left-click again to set it. Right-clicking will abort drawing the vector. 

When the cursor is over a known point (VOR, NDB or waypoint), the name of that point is displayed instead 

of the heading value, and left-clicking will set a direct-to clearance to that point. To temporarily disable the 

known points functionality, keep the <ALT> key pressed while using the vector. 

5.2.4 FAST indicators 

If the FAST function is enabled, separation and/or gap indicators will be automatically displayed for all 

defined approaches to all airports set as active for arrivals in EuroScope. The indicators or the sequence 

orders are not synchronized between controllers. 

The system displays a separation indicator, showing the minimum separation from the preceding aircraft 

(the greater of minimum surveillance separation and wake turbulence separation), and optionally a gap 

indicator which shows a manually defined distance gap behind the previous aircraft. 

The gaps are set from the FAST List, and a pre-defined gap is also automatically entered in front of an 

aircraft with a CAT2 or CAT3 approach clearance. 

 Symbol Color 

Separation indicator ( Symbol overtaken: FTD_Urgency 
Selected track: Track_Highlight 
Otherwise: FTD_Nominal 

Gap indicator [ Symbol overtaken: GAP_Warning 
Selected track: Track_Highlight 
Otherwise: GAP_Nominal 

 

Right-clicking on a gap indicator opens a confirmation window to remove the gap. 

The separation indicator is hidden if: 

- a gap is present, 

- the aircraft hasn’t overtaken the gap indicator, and 

- the separation indicator is further away from the gap indicator than a pre-defined distance 

or 

- the aircraft has an “OS” approach clearance 

The gap indicator is hidden if: 

- the gap is smaller than the required minimum separation 

or 

- the aircraft has an “OS” approach clearance 

If the aircraft overtakes its separation indicator by a pre-defined distance, the symbol will be displayed with 

“FTD_Urgency” color and the overtake distance will be displayed next to the symbol.  
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5.3 Radar Menu 
<ALT> + Right-click anywhere on the radar screen background 

- [] Radar Menu Locks/unlocks the menu display 

- [] Vector On/Off Toggles all prediction lines on/off 

- QDM Starts a new QDM vector 

- SEP Starts a new Minimum separation tool 

- [] Quick Look Toggles function to bypass all filters and show all track labels 

- Maps… Opens the Maps Window 

- Track Control… Opens the Track Control Window 

- View… Opens the View Window 

- Range XXX Opens the Zoom Window (XXX = distance: center -> right edge) 

- Altitude Filter X… Opens the Altitude Filtering Window, displays the filter status 

- SSR Filter X… Opens the SSR Code Filtering Window, displays the filter status 

- CJI Filter X… Opens the CJI Filtering Window, displays the filter status 

- LAT/LONG… Opens the Cursor Lat/Long Window 

- Find Track Opens the SSR Code menu for the Find Track function 

- [] Scale Marker Toggles the Scale Marker on/off 

- [] Direction Finder Toggles the Direction Finder position circles or lines on/off (1) 

 

1) Not shown if the DF system has been disabled in the plugin settings 

When unlocked, the Radar Menu closes when a selection is made or the cursor leaves the menu area. 

5.3.1 QDM vector 

To draw a new QDM vector: 

- Left-click on the “QDM” radar menu item 

or 

Left-click on the “QDM” callsign menu item 

or 

Use the keyboard shortcut key combination for a new QDM vector, 

then 

- Left-click on the desired start point (radar track or fixed position) (1) 

then 

- Left-click on the desired end point (radar track or fixed position) 

 

1) The start point is automatically set to the radar position symbol of the track when starting the 

vector from the callsign menu 

The vector’s data label is located at the end of the line. Its position relative to the line end can be adjusted 

by middle-clicking the line end or the label itself. The available click spots for a radar track are the radar 

track position symbol and all its label items that have a TopSky plugin left-click mouse function. 
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The line end positions will attach to defined points more easily than for a random position (there is a small 

click area centered on the defined points). The defined points have the following priority order: 

- Radar track position symbols 

- VORs in the active sector file 

- NDBs in the active sector file 

- Fixes in the active sector file 

- Airports in the active sector file 

Right-clicking will abort drawing the vector. 

To remove a QDM vector: 

- Right-click on either end point or the midpoint of the line or the label 

To adjust a QDM vector: 

- Left-click on either end point. The selected end of the line will attach to the mouse cursor. 

then 

- Left-click on the new desired end point (radar track or fixed position) 

5.3.2 Multi-QDM vector 

When the start point of a QDM vector is a fixed point and the end point a track, the system automatically 

starts another QDM vector from the same start point. If it is attached to another track, the vectors are 

grouped together as a multi-QDM, and another vector is again automatically started from the same start 

point. This happens until the right mouse button is clicked to abort drawing a new vector (or the maximum 

number of QDM vectors is reached). 

The advantage of the multi-QDM vectors is that when hovering over a track label of one of the tracks, a 

relative distance indication is added to the labels of all other vectors belonging to the same multi-QDM 

group, showing in parentheses the difference in the distance value compared to the selected track. 

5.3.3 Minimum separation tool 

The minimum separation tool displays the predicted minimum lateral separation between two radar tracks, 

assuming both of them maintain their present ground tracks and speeds. Lines are drawn from the tracks’ 

present positions to the positions where the tracks are predicted to be at the time of the minimum 

separation. 

To draw minimum separation lines between two radar tracks: 

- Left-click on the “SEP” menu item 

then 

- Left-click on the first radar track 

then 

- Left-click on the second radar track 

Right-clicking will abort drawing the lines. The available click spots for a radar track are the radar track 

position symbol and all its label items that have a mouse function. 
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The minimum separation distance is by default displayed near the end of one of those lines. If the tracks 

are not converging, the lines will be drawn with an offline-defined length, and the label will display “DIV”. 

20 sets of lines can be simultaneously drawn. When at least one set is drawn, a SEP List Window is opened: 

 

The window lists the tracks, the minimum predicted separation, the time to the minimum separation, the 

line color and a locked/unlocked indicator for each set of lines. 

To remove the minimum separation lines: 

- Left-click on the colored box for that set of lines in the SEP List Window 

or 

- Right-click on a line’s end point 

or 

- Close the SEP List Window (this removes all minimum separation lines) 

The lines will be automatically removed if one of the tracks is no longer available, or for unlocked lines, if 

the tracks start to diverge. If the tracks are diverging at the time the lines are created, they will be 

automatically locked. 

To lock/unlock a set of lines: 

- Left-click on the box right of the color indicator for that set of lines to toggle the locked/unlocked 

status. For a locked set of lines, the box will be filled. 

To display vertical separation information on the lines: 

Right-click on the colored box for a set of lines cycles through 

- “V”  Vertical separation display enabled 

- “v”  Vertical separation display enabled without the vertical separation labels 

- blank  Vertical separation display disabled 

When vertical separation display is enabled, on both lines two points are displayed, the first showing the 

point where the tracks’ vertical separation is calculated to become smaller than an offline-defined value, 

and the second the point after that where it is calculated to become greater. The calculation is done using 

the tracks’ current vertical speeds. 

- The vertical separation labels, when displayed, are similar to the minimum separation label but 

prefixed with “v”. 

- If one or both points are beyond the minimum separation point, their calculation is extended 

forward up to an offline-defined time value. 

- If a point is already passed or beyond the maximum displayed time, it will not be drawn. 

- If the end point is beyond the maximum displayed time, a line will be drawn using “Sep Vert” color 

from the CPA to the end point or the maximum displayed time whichever is earlier. 

- If the tracks are not predicted to be vertically separated within the prediction time, “v=” is 

displayed near the track whose line contains the separation distance label. 
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5.3.4 Maps Window 

Radar Menu -> Maps… 

 

The Maps Window closes when the mouse cursor leaves the window area. If this is not desired, there is a 

hidden click spot in the top right corner of the menu (where the “close” button would be). Left-clicking in 

that area will disable the automatic closure of the menu and display the close button, which is then used to 

close the menu. 

The Maps Window enables the display of predefined maps on the radar screen, some of which may be set 

up with automatic activation rules. The maps are arranged to folders. Clicking on a folder name shows the 

maps in that folder below the folder list. 

The map names are displayed with the following colors (automatic options only available for maps with 

that capability): 

 Text color Background color Map state 

Name “Foreground” “Background” Not displayed 

Name   “Foreground” “Arm” Automatic (not displayed) 

Name   “Background” “Arm” Automatic (displayed) 

Name “Background” “Foreground” Displayed 

 

Left-clicking on a map name will change the state of a map one step 

not displayed   -->   automatic (if applicable)   -->   displayed 

right-clicking in the other direction. Left or right double-clicking on any map name will change the states of 

all maps in that folder. 

Besides any maps from the data file, the following automatically generated maps are available: 

- Aerodromes 

o AD_Hotspots Aerodrome symbols that are used to open the 

   Runway In Use Window and Runway Approach Line Window 

- MISC (1) 

o AIRPORTS (+ L) Airports (with labels) from the active sector file 

o FIXES (+ L) Fixes without numbers (with labels) from the active sector file 

o FIXES ALL (+ L) All fixes (with labels) from the active sector file 

o NDBS (+ L) NDBs (with labels) from the active sector file 

o VORS (+ L) VORs (with labels) from the active sector file 

- TSA 

o <area name> TSA areas from the areas data file 
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1) The color used for the symbols is “Auto Map Symbol” and for the labels “Auto Map Label”. 

Depending on the sector file setup, there can also be one or more maps named “FIXES x” (where 

“x” is a group name given in the sector file). These are actually NDBs or VORs in the sector file. To 

create such a group, put a fake navaid with the name “!x!” in the sector file, where “x” is the 

desired group name. All following navaids of that type will be put in the “FIXES x” map. The same 

group name can only be used once in a sector file. The items in these maps will look like the items 

in the “NDBS” or “VORS” maps, depending on which section the items are placed in the sector file. 

The visibility of some elements from the active sector file can also be toggled using the Maps Window. 

These are found in the “ARTCC HIGH”, “ARTCC”, “ARTCC LOW”, “AIRWAYS H”, “AIRWAYS L”, “SID”, 

“STAR”, “GEO”, “REGIONS” and “FREE TEXT” folders. The plugin does not know their display state, their 

names will always be shown with “Arm” text color on “Background” color background. 

The “AIRWAYS L” and “AIRWAYS H” folders present the airways organized into groups. The default group 

is “PERM”. An airway can be assigned to a custom named group by having the group name in parentheses 

in the airway name. Airways with “[1]”, “[2]” or “[3]” found in their names will be assigned to groups “CDR 

1”, “CDR 2” and “CDR 3” respectively. Custom group names and the CDR numbers can be combined, for 

example airway segments named “A1(x)[1]” and “A2(x)[1]” in the sector file would be labeled “x CDR 1” in 

the maps list. Additionally, one map with the group’s name is created that contains all airways in the group 

regardless of the PERM or CDR status. 
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5.3.5 Track Control Window 

Radar Menu -> Track Control... 

The Track Control Window is used to set track and track label related options. Note that the “Vector” 

selection must be on (see Radar Menu and Shortcut Window) to see the prediction lines. The Track Control 

Window closes when the mouse cursor leaves the window area. The selections are specific to the radar 

screen they are made on, but whenever the plugin settings are reloaded either automatically (sign in/out, 

login callsign change when signed in) or manually the selections on all radar screens will revert to the 

default values. 

 

- Vector Sets the length of the prediction line in minutes 

- History Sets the number of history dots 

- Text Changes the track label text size 

- … Fields Opens/closes the corresponding Label Fields section 

The Label Fields sections allow controlling the visibility of certain 

track label fields in the unselected label, and for DAP items, also in 

the selected label. The visibility can be set depending on the state 

of the flight plan (Coordinated, Assumed, Redundant or 

Notified/Unconcerned). 

 

The “All” buttons toggle all the state buttons for that field on/off.  

 

The “OFL+” buttons are only shown in oceanic setups, the “AMA” 

buttons only if the plugin is set up to display AMAN data. 

 

Regardless of the settings here, the necessary label fields will be 

displayed in certain cases (for example in case of a COPX 

coordination request, the COPX field will be displayed). The default 

label field selections are as displayed in the image. 
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5.3.6 View Window 

Radar Menu -> View… 

 

The View Window lists the available views. To select a view, left-click on it. The radar screen will be 

refreshed to show the required area. The first three views, labeled “1”, “2” and “3” are views that can be 

defined on the fly. To define a view for one of them, set the screen area as desired and then right-click on 

the number. The number will then change to “Foreground” color to indicate that it has a view defined for it. 

An already defined view (“1”, “2” or “3”) can be redefined to show a different screen area just by defining it 

again with a right-click. 

5.3.7 Zoom Window 

Radar Menu -> Range XXX 

 

The Zoom Window displays and enables to change the radar screen range. 

5.3.8 Track filtering 

For all the filters, it is only possible to filter out unconcerned tracks. Aircraft with transponder codes 7500, 

7600 and 7700, tracks with an STCA, MSAW, APW, TCT or DUPE alert, highlighted tracks, and tracks subject 

to Blind Spot function alerts are also excluded from filtering. If a filter is active, its name in the Radar Menu 

will be shown in “Selected” color. 

All filters with the exception of the CJI filter remove all components of the tracks, nothing remains visible. 

The CJI filter leaves the track position symbol and history dots visible. 

The filters can be overridden using the Quick Look (all filters), Quick Look Up/Down (altitude filter only) and 

Individual Quick Look (CJI filter only) functions. 

5.3.8.1 Altitude Filtering 

Global Menu -> “Mxxx-yyy” item 

Radar Menu -> Altitude Filter [ON/OFF]… 

The Altitude Filtering Window is used to filter the displayed track labels based on the 

aircrafts’ altitudes.  It closes when the mouse cursor leaves the window area. 

To set the filtering limits, values from -1200ft to FL660 are available with 100ft steps 

up to 5000ft, then with 500ft steps up to FL660. Select the level and click on the filter 

on/off button to activate the limit. There are separate on/off buttons for the upper 

and lower limits, and it is possible to activate either one or both of them. Values at or 

below the transition altitude are considered to be altitudes (for example with a 

transition altitude of 5000ft, “050” means 5000ft and “055” means FL55). 
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5.3.8.2 SSR Code Filtering 

Radar Menu -> SSR Filter [ON/OFF]… 

 

The SSR Code Filtering Window is used to filter the displayed track labels based on the aircrafts’ SSR codes. 

Four different codes or code ranges can be set. The boxes on the left side of the window are the code range 

start boxes. The input syntax is a valid SSR code to be filtered. If filtering a range of codes is needed, enter 

the last two digits of the last code in the range to the box on the right. Entering an empty string will clear 

the box. For example, to filter codes 1400-1427, enter “1400” into one of the four boxes on the left and 

then “27” into the box next to it. Set the filter on by clicking on the filter on/off button. 

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes, closes the window 

- Apply  Applies the changes 

- Cancel Cancels any changes, closes the window 

5.3.8.3 CJI Filtering 

Radar Menu -> CJI Filter [ON/OFF]… 

The CJI Filtering Window is used to filter the displayed track labels based on 

controller ID’s.  The window shows the currently online controllers. To filter a 

controller’s tracks, click on the controller ID in the list. A filtered ID will be shown in 

inverse video. 

The “Uncoup labels” button controls filtering for uncoupled labels (this function is 

available also in Shortcut Window). 

Clicking “All” filters all controllers, “None” clears all controller ID filters. 

The CJI Filtering Window closes when the mouse cursor leaves the window area. 

5.3.8.4 Primary Track Filtering 

Shortcut Window -> “Prim Tracks” button 

When enabled, primary track filtering filters out all primary tracks. 

5.3.8.5 Uncontrolled Flight Filtering 

Shortcut Window -> “Uncont Flights” button 

When enabled, uncontrolled flight filtering filters out all uncontrolled flights not “On-contact” with you. 
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5.3.8.6 Quick Look 

Radar Menu - > “Quick Look” button 

Shortcut Window -> “Quick Look” button 

Keyboard shortcut 

The Quick Look function can be used to override all filters. It is a toggle function and will stay active until 

toggled off. 

5.3.8.7 Quick Look Up/Down 

Keyboard shortcut 

The Quick Look Up/Down functions can be used to toggle the upper/lower altitude filters on/off without 

having to open the Altitude Filtering Window. They correspond to clicking the respective filter on/off 

buttons. 

5.3.8.8 Individual Quick Look 

Middle-click aircraft position symbol 

The Individual Quick Look function can be used to override the CJI filter for a specific track and to display 

labels for uncoupled primary tracks which are normally automatically hidden. It is a toggle function, middle-

clicking again will hide the labels again. 

5.3.8.9 Level Band Highlight 

“Toggle Level Band Highlight (AFL)” tag function 

“Toggle Level Band Highlight (XFL)” tag function 

While active, this function highlights the callsigns of the referenced flight and the callsigns of all other 

flights within the level band of the referenced flight. The prediction line is forced on for these flights. 

All other flights will be filtered out to display just their track position symbols and history dots unless they 

have an active STCA, APW, MSAW, AIW or TCT alert or are squawking 7500, 7600 or 7700. Tracks without a 

valid AFL will be filtered out. 

5.3.8.10 Oceanic Level highlight 

“Toggle Oceanic Level Highlight” tag function 

“Acknowledge OCM/Toggle OFL Highlight” tag function (when OCM has been acknowledged) 

While active, this function highlights the callsigns of the referenced flight and the callsigns of all other 

flights having the same OAN and OFL. The prediction line is forced on for these flights. 

All other flights will be filtered out to display just their track position symbols and history dots unless they 

have an active STCA, APW, MSAW, AIW or TCT alert or are squawking 7500, 7600 or 7700. 
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5.3.9 Lat/Long Window 

Radar Menu -> LAT/LONG… 

 

Displays the latitude and longitude values of the cursor position. 

5.3.10 Find Track 

Radar Menu -> Find Track 

“Find ASSR” tag function 

“Find PSSR” tag function 

The Find Track function highlights for a specified time all labels matching the specified TSSR, ASSR or PSSR 

with Temp Track Highlight color. 

5.3.11 Scale Marker 

Radar Menu -> [] Scale Marker 

 

Displays a range scale in the bottom right corner of the radar screen.  
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6 Track label menus 
These menus are opened from track label fields or flight lists. Except for the confirmation windows, they 

are closed automatically when a menu option is chosen or the mouse cursor leaves the menu area. The 

mouse wheel can be used to scroll the selection lists in the menus. 

Many of the menus have a default item or value, displayed with inverse video. The menu usually opens so 

that the default value is located under the mouse cursor for easy selection. Some menus contain items that 

open folders within the menu. They show a filled triangle before the item name (upright if the folder is 

closed, inverted if the folder is open). The “More” folder is opened automatically when the mouse cursor is 

placed over it or if the default item is in the “More” folder, other folders must be left-clicked to open. 

6.1 Callsign menu 
Items in the callsign menu that are currently not available (for example “Assume” for a track that is not free 

or being transferred in) are hidden to make the menu as small as possible, so the example images below do 

not show all the possible items. In the other menus the unavailable items are displayed with “Arm” color. 

6.1.1 Controlled track 

- Assume Assumes track 

- Refuse Refuses the incoming transfer 

- Transfer Initiates a transfer to the next sector 

- Trf & Release Opens the Transfer & Release menu 

- ROF  Sends a Request On Frequency message 

- (X)Freq Toggles the Freq indicator 

- Vector Opens the Prediction Line menu 

- QDM  Starts a QDM line from this track 

- (X)Highlight Toggles the Callsign highlight 

- (X)S-Highlight Toggles the Callsign+AFL fields highlight 

-  More Shows additional less frequently used options (see below) 

 

- (X)Hold “Hold” opens the Hold/Susp menu, “XHold” cancels a given holding clearance 

- Man Trf Opens the Manual Transfer menu 

- HOP  Initiates a Handover Proposal 

- (X)Mark Toggles the Mark indicator 

- FPL  Opens the Flight Plan Window 

- Start/End CPDLC Starts/Ends CPDLC connection with the aircraft 

- VCI  Opens the VCI menu 

- Squawk Ident Sends a “SQUAWK IDENT” CPDLC message to the aircraft 

- CPDLC Free Text Opens the CPDLC Free Text menu 

- Free  Releases track 

- (X)Inbound Est Toggles the “Inbound Est” manual alert 

- (X)Irregular Toggles the “Irregular” manual alert 

- (X)Missed App Toggles the “Missed App” manual alert  

- (X)Weather Toggles the “Weather” manual alert  

- On Contact Sets track in On-Contact state (1) 

- (X)Couple Uncorrelates/correlates the flight plan 
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Besides the manual alerts, none of the selectable toggle options in this menu will be transmitted to other 

controllers, but the “Mark”, “Freq” and highlight selections will be seen in your other EuroScope instances. 

A holding clearance is broadcast to all controllers in range when given, and additionally transmitted to the 

next controller when transferring the track. To correlate a flight plan, first click on the “Couple” item, and 

then click on the radar position symbol of the desired radar track. 

1) Clicking “On Contact” for a track with “Y” or “Z” flight rules will also automatically change the flight 

rules in the VATSIM flight plan to VFR in order to make it uncontrolled. The displayed flight rules 

are not affected. 

 

6.1.2 Uncontrolled track 

- On Contact Sets track in On-Contact state 

   (“Assumed” color, can’t be filtered, but still uncontrolled) 

- Assume Assumes track (which then changes it to a controlled track) (1) 

- Vector  Opens the Prediction Line menu  

- QDM  Starts a QDM line from this track 

- (X)Highlight Toggles the Callsign highlight 

- (X)S-Highlight Toggles the Callsign+AFL fields highlight 

-  More Shows additional less frequently used options (see below) 

 

- (X)Hold “Hold” opens the Hold menu, “XHold” cancels a given holding clearance 

- (X)Mark Toggles the Mark indicator 

- (X)Freq Toggles the Freq indicator 

- Free  Releases track 

- FPL  Opens the Flight Plan Window 

- (X)Couple Uncorrelates/correlates the flight plan 

 

1) Clicking “Assume” for a track with “Y” or “Z” flight rules will also automatically change the flight 

rules in the VATSIM flight plan to IFR in order to make it controlled. The displayed flight rules are 

not affected. 

 

6.1.3 Uncorrelated track 

- IFR APL  Opens the Create APL Window (with FRUL=I and S-Highlight on) 

- Create APL Opens the Create APL Window 

- Vector  Opens the Prediction Line menu 

- (X)Highlight Toggles the TSSR/FLTID highlight 

- Couple Correlates the radar track with the next clicked “Callsign” field 

- QDM  Starts a QDM line from this track 
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6.1.4 Transfer menu 

For CPDLC connected aircraft, the menu contains options related to the transfer. Left-

clicking on the frequency button initiates the transfer (and sends the CPDLC message if 

selected). 

“Monitor” / “Contact” select which of the two CPDLC message types will be sent. 

“R/T” / “CPDLC” select whether the transfer instruction is given via radio or as a CPDLC 

message.  

 

6.1.5 Transfer Confirmation Window 

 

If an aircraft has a defined XFL value and hasn’t been cleared to it (CFL is not equal to XFL), attempting to 

transfer the aircraft will open a Transfer Confirmation Window in the middle of the radar screen. While the 

window is open it will block all other attempts to click on items elsewhere on the radar screen. Either click 

on “Transfer” to transfer the aircraft regardless of the situation, or “Cancel” to cancel the transfer. 

 

6.1.6 Transfer & Release menu 

The Transfer & Release menu allows specifying a release condition for a track to be 

transferred. The transfer is initiated after selecting the desired condition (climb, descent, 

turn or full). The release will be shown on line 0 of the track label (C for climb, D for 

descent, T for turn and F for full). The transferring controller will see the label item until 

the track becomes unconcerned. The receiving controller will see the item for 3 minutes 

after the track is assumed. 

For CPDLC connected aircraft, the menu contains options related to the transfer: 

“Monitor” / “Contact” select which of the two CPDLC message types will be sent. 

“R/T” / “CPDLC” select whether the transfer instruction is given via radio or as a CPDLC 

message.  

 

 

 

 Warning:  The “Trf & Release” option will show the release condition on the downstream side only if the 

next controller is using this plugin, in other cases the transfer will be shown as a normal transfer. 
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6.1.7 Request On Frequency message 

The ROF message can be used to send a request to the controller currently tracking an aircraft to transfer it 

to your frequency. For the message to succeed, you must be seen as the next controller for the tracking 

controller. When sent, the text “ROF” is displayed in the track label on the tracking controller’s screen. 

 Warning:  The “ROF” message is a feature specific to this plugin. It is an experimental feature and is not 

guaranteed to work all the time. When you send the message, check that it’s sent properly. 

- A successfully sent message will be displayed in the Message Out Window 

- If there is an error or the message fails to go through, a message will be put into the Personal 

Queue Window. 

 

6.1.8 Hold/Susp menu 

The Hold/Susp menu allows you to enter a holding clearance (add the aircraft to the 

holding list). It displays for selection the points in the aircraft’s route that are ahead of 

its current position. 

Left-clicking the empty box below the waypoint list opens a text entry box to enter any 

holding point name. 

Left-clicking “Here” enters the present position coordinates as the holding point. 

The “Suspend” folder contains a list of all currently active TSA areas. Left-clicking on one 

sets the aircraft to a TSA Hold. A TSA Hold clearance will exclude the aircraft from all 

APW and SAP processing. 
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6.1.9 Manual Transfer menu 

The Manual Transfer menu allows transferring the aircraft to any controller. In the 

SCHEDULED list are the controllers that are in the current sector sequence sorted in the 

order the aircraft is planned to enter the controllers’ sectors, with the next controller 

being the default item. 

When opened, the “More” list displays all the other controllers for selection. Click on a 

controller ID to start the transfer. For CPDLC connected aircraft, clicking on a controller 

ID opens the Transfer menu. 

 

 

 

 

 

 

6.1.10 VCI menu 

Available only for CPDLC-connected aircraft and when more than one frequency has 

been set up by the controller, the VCI menu allows sending a CPDLC “contact” or 

“monitor” message without initiating a transfer. 

The first button displays the primary frequency, left-clicking it will send the message 

with that frequency. 

Left-clicking the “Select Freq” button will open a text entry box to enter any other 

frequency. If a valid frequency (set up as XMT TXT in EuroScope’s Voice communication 

setup dialog) is entered, the message will be sent with that frequency. 

“Monitor” and “Contact” are used to select the type of message to be sent. 

 

6.1.11 CPDLC Free Text menu 

The CPDLC Free Text menu is used to send a free text CPDLC message to the aircraft. The menu contains 

pre-defined messages from a data file. Left-clicking on a message sends it. 

The menu closes when a message is sent or the cursor leaves the menu area. 
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6.1.12 Prediction Line menu 

The Prediction Line menu allows displaying a PRL with a specific length for each aircraft 

even if the PRL selection is off in the Radar Menu. 

The default value is the set PRL value if available, otherwise the PRL length value from 

the Track Control Window. Changing the PRL length value in the Track Control Window 

or changing the PRL setting in the Radar Menu will delete all manually set PRL lengths. 

 

 

 

 

6.2 Sequence number menu 
This menu is used to set a manual arrival sequence number. Values from 1 to 50 are 

available. 

The sequence number will not be transmitted to other controllers except the next 

controller (during transfer) unless the flight strip is manually sent. 
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6.3 Waypoint menu 
This menu gives access to functions related to the route of the aircraft. It is used to assign 

direct-to clearances, holding clearances, and to coordinate the sector entry/exit point. 

 Left-clicking  on a point in the list sets a direct-to clearance to that point. Any point name 

can be manually entered in the box at the bottom of the menu. Note that no coordination 

is performed. If coordination is necessary,  right-click  any point name to open the 

EuroScope “COPN/COPX point” popup list or use the “Probe” button instead.  

When the aircraft is CPDLC-connected, the menu offers a choice between “R/T” and 

“CPDLC”. The chosen option decides how a clearance is communicated to the aircraft. 

“Probe” opens the EuroScope “COPN point” or “COPX point” popup list and draws the 

Flight Leg for the flight. Moving the mouse cursor over the points in the popup can be 

used to probe the effects of possible route changes. Allow up to 5 seconds after each 

point change for FPCP to update. The popup is also used to start point coordinations. 

For “HOP” see AHDG menu. 

Left-clicking “Hold” opens the Hold menu. If a holding clearance already exists, the button 

will read “XHold” and clicking it will remove the clearance. 

 

When an entry or exit coordination has been received, the menu options are: 

- Accept Accepts the coordination 

- Reject Rejects the coordination 

- Probe Opens EuroScope popup to counter-propose another point 

With “CPDLC” selected, when “Accept” is clicked, in addition to the coordination being 

accepted, a “PROCEED DIRECT TO <point>” CPDLC message is sent to the aircraft. 

 

When a direct-to downlink request has been received, the menu can be used to answer it. 

- Point name Sends a “PROCEED DIRECT TO <point>” CPDLC message 

- SBY  Sends a “STANDBY” CPDLC message 

- UNABLE  Sends an “UNABLE” CPDLC message 

 

The “R/T” / “CPDLC” selection is fixed to “CPDLC”. 

 Warning:  Clicking the point name will set the direct-to clearance without coordination 

When there is no request in process and the aircraft has a direct-to point set, the menu 

can be used to send the clearance via CPDLC. In this case the menu opens like this except 

without the “SBY” and “UNABLE” buttons. Clicking the point name will send the 

“PROCEED DIRECT TO <point>” CPDLC message.  



40 
 

6.4 AFL menu 

     
   nautical units            metric units 

This menu can be used to set the AFL value for aircraft that don’t have an altitude reporting transponder. 

The default value is the previously set manual AFL value if set, otherwise the CFL value. 

By default, the menu (as well as the AFL label item) is always showing nautical units, regardless of the 

system units or the selected units for the aircraft. If this behavior is selected off and toggling level units via 

menus has been set up (default=no), the list units can be toggled with the “NAUTICAL” / “METRIC” item. 

There are two ways to set the AFL using this menu: 

- Clicking a level value in the list 

- Clicking the text entry box below the level list and entering the value there 

Entering a metric value will also set the aircraft’s units to metric; a nautical value will set nautical units. 

 

The accepted manual level entry formats for the AFL, CFL and RFL menus are as follows (“n” is a number): 

- “Annn” or “nnn”  Altitude in hundreds of feet 

- “Mnnnn” or “nnnn”  Altitude in tens of meters 

- “Mnnnnn” or “nnnnn” Altitude in meters 

- “Ennn”  Height in hundreds of feet above aerodrome elevation 

- “Ennnn”  Height in tens of meters above aerodrome elevation 

- “Ennnnn”  Height in meters above aerodrome elevation 

Regardless of whether the entered value is in meters or feet, and altitude or height, it will be converted to 

altitude in feet and the result is then rounded to the nearest 100 feet. 

 Note:   The metric level values in the documentation are shown with 5 digits (meters). Depending on the 

plugin setup, they may also be shown with 4 digits (meters/10). 
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6.5 CFL menu 
The CFL menu is available only when the aircraft is assumed. The default value is by default 

the XFL, but it can be changed to the current CFL or the RFL in the Local Settings menu. 

Altitudes up to the transition altitude are prefixed with “A” in the nautical units list and 

with “M” in the metric units list. QFE heights are prefixed with “E” in both lists. Selectable 

values are from 500ft to FL510 with 500ft intervals up to the transition altitude, then 1000ft 

intervals up to FL410 and 2000ft intervals above it. 

The aircraft’s RFL is displayed above the level list with format “R<RFL>”. Left-clicking it sets 

the CFL equal to RFL, right-clicking toggles the units between nautical and metric if toggling 

level units via menus has been enabled. 

- “CA” sets “Cleared for approach” 

- “VA” sets “Cleared for visual approach” 

- “OS” sets “Own separation” (FAST indicators hidden, treated as visual approach by safety nets) 

The “APP Clr” folder contains other available approach types for the aircraft’s arrival 

runway. If none are defined in the plugin settings, the folder is not displayed in the menu. 

 Warning:  The clearances in the “APP Clr” folder will be displayed as “cleared for approach” 

to controllers not using this plugin (“OS” will be “cleared for visual approach”) 

“Probe” toggles a CFL probe function and displays the Flight Leg. Moving the mouse cursor 

over the levels in the list will show the MTCD/SAP effects of setting that value as the CFL 

(allow a couple of seconds for the FPCP to update the calculations). 

There are four ways to set the CFL using this menu: 

- Clicking the RFL value 

- Clicking a level value in the list 

- Clicking one of the approach clearance items 

- Clicking the text entry box at the bottom of the menu and entering the value there 

Entering a metric value will set the aircraft’s units to metric; a nautical value will set 

nautical units. 

For CPDLC connected aircraft, the menu contains “R/T” and “CPDLC” options to select 

whether a level clearance is to be sent via radio or as a CPDLC message. 

When a level request downlink has been received, the “R/T” option is deselected and 

cannot be selected. The request must be replied to using CPDLC. A clearance to the 

requested or some other level is given using this menu. The “STANDBY” and “UNABLE” 

responses are sent from the RFL menu. 

When a level clearance uplink is waiting for reply, the “CPDLC” option is deselected and 

cannot be selected. If a new level clearance must be sent before there is an answer to the 

uplink, it must be given using R/T (doing so also closes the open uplink message). 
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6.6 RFL menu 
The RFL menu allows setting the requested flight level. The operation is similar to the 

AFL and CFL menus. The function for the “-->” button is not implemented. 

 

 

 

 

 

 

 

 

For CPDLC connected aircraft, if a level request has been received from the aircraft, 

there are also “SBY” and “UNABLE” buttons to send those messages as a reply. For 

clearing the aircraft to the requested or some other level, the CFL menu must be used. 
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6.7 AHDG menu 
This menu includes items to set or clear an assigned heading or a direct route and to send a 

HOP. The initially highlighted heading value will be the closest one to the assigned heading 

if the aircraft has one, otherwise the closest one to the aircraft ground track (or the 

departure runway heading if the menu is opened from the DEP list). Clicking on a heading 

value will set it as the assigned heading. The assigned heading can also be set by typing it 

into the entry box or by using the AHDG vector. 

“LLZ” enters a localizer clearance. 

The “More” folder contains the following additional options: 

“Point” lets you pick a direct-to point from the radar screen. Left-click on any point to set it 

as the direct-to point (VORs, NDBs and waypoints, in that priority order). Pressing the [Esc] 

key or clicking on any clickable data field will abort the operation. 

“HOP”, “RTI” and “TIP” are coordination functions (see below for more information). To use 

them, first click on the function’s button and then select the desired value from the list (for 

HOP also “Point” is available). 

“Clear” removes an assigned heading or a direct route. For CPDLC connected aircraft, it 

sends the “RESUME OWN NAVIGATION” CPDLC message if the “CPDLC” option is selected. 

For CPDLC connected aircraft, the menu contains additional buttons: 

“R/T” and “CPDLC” select whether a heading/direct-to clearance is to be sent via radio or 

as a CPDLC message. 

- When a heading request downlink has been received, the “R/T” option is deselected and 

cannot be selected. The request must be replied to using CPDLC. 

- When a heading/direct-to clearance uplink has been sent, the “CPDLC” option is deselected 

and cannot be selected. If a new heading/direct-to clearance must be sent before there is 

an answer to the uplink, it must be given using R/T (doing so also closes the open uplink 

message). 

“SBY” and “UNABLE” send the corresponding answers to a downlink heading request 

message. 

 Warning:  Clicking a point on the radar screen will set the direct-to clearance without 

coordination 
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6.7.1 Handover Proposal (HOP) 

A Handover Proposal can be used to propose non-standard transfer parameters (AHDG/Direct-to, ARC and 

ASP) to the next sector. For the receiving controller a HOP is identified by coloring the callsign data field 

with “Proposition” color in the label. For the sending controller the Callsign field remains “Assumed” color 

and the Sector Indicator field is shown in “Proposition” color. Additionally, if there are proposed 

parameters they are also colored “Proposition” in both controllers’ labels. 

There are three ways to answer a HOP and all of them involve accepting all proposed parameters. If one or 

more parameters are not acceptable, coordination must be done to find acceptable parameters or to revert 

to standard ones. The available ways to accept the proposed parameters are: 

- Callsign menu -> “Assume”  Assumes the track 

- Callsign menu -> “ROF”  Sends a Request On Frequency message 

- Combined Transfer menu -> “Accept” Sends an Accept message 

If the parameters are unacceptable to the receiving controller, the sending controller has the possibility to 

modify or clear them using the appropriate menus, or to cancel the whole HOP by assuming the track. 

 Warning:  A HOP will only be shown correctly for controllers using this plugin. To other controllers it will be 

shown as a normal transfer without any special coloring of any data fields. This combined with 

the three possible ways to answer the HOP require the sending controller to pay special 

attention to the track to see what the result is. 

 Warning:  If a HOP is sent to a manually selected controller, the next controller selection will be reset to 

the automatically calculated controller when an “ROF” or “Accept” answer is received. The 

correct controller must then be manually selected again for the transfer. 

6.7.2 Request Tactical Instructions (RTI) / Tactical Instructions Proposal (TIP) 

Certain tactical data (AHDG, ASP and ARC) can be coordinated using the RTI and TIP functions. Their only 

difference is that RTI is used for requesting the parameters when the aircraft is inbound to your sector and 

your sector is the next in the sector sequence, and TIP for proposing the parameters to the next sector 

when the aircraft is assumed. Contrary to the HOP function, these coordinations can be refused using the 

system, and they do not offer the aircraft for transfer. 

To answer the RTI/TIP, open the AHDG menu. For TIP, the menu contains just two options, 

“Ack” (accept proposal) and “Reject” (reject proposal). For RTI, an additional “Accept” 

option is available. Like “Ack”, it accepts the proposal, but it also sets the value. For CPDLC 

connected flights, the “R/T” and “CPDLC” options are used to determine whether the 

clearance is to be sent as a CPDLC message or using RTF. 

 

 Warning:  It is possible to have received more than one type (AHDG/ASP/ARC) of RTI/TIP. When answering 

one of them, the same answer will be sent to all the others as well. When selecting the “Accept” 

option, only that type’s value will be set (for example when AHDG and ASP RTI have been 

received and selecting “Accept” from the AHDG menu, both RTIs will be accepted but only the 

AHDG value will be set accordingly, and ASP value will have to be set separately) 
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 Warning:  The “RTI” and “TIP” messages are features specific to this plugin. They are experimental features 

not guaranteed to work all the time. When you send these messages, check that they are sent 

properly. 

- A successfully sent message will be displayed in the Message Out Window and the requested 

parameter being shown in the track label 

- If there is an error or the message fails to go through, a message will be put into the Personal 

Queue Window. 

 

 

6.8 ARC menu 
The ARC menu allows assigning a rate of climb or descent to the flight plan. Values are 

displayed in 100’s of ft/min or 5-25 m/s. 

Left-clicking on a value assigns it. Clicking the “-” or “+” next to a value sets the clearance as 

a maximum or minimum rate respectively. Clicking the value itself will set the clearance as 

an exact rate. 

For “HOP”, “RTI” and “TIP” see the AHDG menu. 

An assigned rate can be cleared by selecting the “Clear” item. 

 

 Warning:  The exact and maximum rate clearances are a feature specific to this plugin (the 

additional information is stored in the flight strip). To controllers not using the 

plugin, all assigned rate clearances will only show the rate value. Assigned rate 

clearances given by controllers not using the plugin will be displayed as 

minimum rate clearances.  
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6.9 ASP menu 
The ASP menu allows setting an assigned speed or Mach 

number. The default value will depend on the assigned one if 

set (assigned+20kts for departures, assigned or slightly less 

for arrivals), otherwise it will be either a pre-defined value or 

the current DMACH if available. The menu will initially open 

in IAS mode if the aircraft’s CFL is below a defined value 

(FL275 by default), and in Mach mode if above it. The 

selectable values range from 100 to 400 knots and from 

Ma0.50 to Ma1.00. 

Left-click the units button to toggle between IAS and Mach, 

right click when in IAS mode to toggle between KNOTS and 

Km/h (if speed unit toggling via menus has been set up). 

The “HS” option will set a clearance for “high speed”, 

displayed as “HS” in the ASP label field. 

The “+” and “-” options can be used to specify the clearance 

as a minimum/maximum speed. 

For “HOP”, “RTI” and “TIP” see the AHDG menu. 

The “Resume” item clears an assigned value. For CPDLC 

connected aircraft, it sends the “RESUME NORMAL SPEED” 

CPDLC message if the “CPDLC” option is selected. 

Entering a metric value will set the aircraft’s units to metric; a 

nautical value will set nautical units. 

For CPDLC connected aircraft, the menu contains additional buttons: 

“R/T” and “CPDLC” select whether a speed clearance is to be sent via radio or as a CPDLC 

message. 

- When a speed request downlink has been received, the “R/T” option is deselected and 

cannot be selected. The request must be replied to using CPDLC. 

- When a speed clearance uplink has been sent, the “CPDLC” option is selected and cannot 

be deselected. If a new speed clearance must be sent before there is an answer to the 

uplink, it must be given via radio (doing so also closes the open uplink message). 

“SBY” and “UNABLE” send the corresponding answers to a downlink speed request. 

 Warning:  The minimum, maximum and high speed clearances are a feature specific to this 

plugin. To controllers not using the plugin, all assigned speed clearances will only 

show the speed value (999 for the high speed clearance). Assigned speed 

clearances given by controllers not using the plugin will be displayed as exact 

speed clearances. 
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6.10 SSR Code menu 
The SSR Code menu allows assigning an SSR code to the flight plan. To enter a new code, 

type it by left-clicking the numbers. “C” clears the entered value and “Ok” assigns the 

code if it’s a valid one. To get an automatically assigned code, left-click the “Get SSR” 

button. 

Depending on the configuration, the assigned code may be a mode S conspicuity code. 

To force a discrete code, make a new assignment – either manual or automatic. If an 

automatic assignment is requested for a flight with the conspicuity code currently 

assigned, the new assignment will be a discrete code. 

When the SSR Code menu is opened to start the Find Track function, the top row of the 

menu will read “Find” and the “Get SSR” button will not be present. Enter a code and 

click “Ok” to start the function. 

 

6.11 Combined Transfer menu 
The Combined Transfer menu displays the proposed transfer parameters for a HOP. It is 

opened by clicking on the AHDG, ASP or COPN/COPX items in the track label or flight list, 

or the list row displaying the HOP message in the Message In Window. 

From top to bottom, the displayed values are the direct-to point, speed/Mach value, 

and the assigned heading value. If one or more of them are not proposed, the value will 

be replaced by the string “none” (the image above shows the menu for a HOP without 

any proposed parameters). Clicking on “Accept” will send a message to the upstream 

controller that the proposed parameters, if any, are all acceptable. 

 

6.12 Aerodrome menu 
The Aerodrome menu is used to select the aerodrome(s) for aerodrome related 

windows and functions. The list contains all aerodromes with runways defined in the 

active sector file. To select an aerodrome, left-click on it or type its identifier into the 

text entry box below the list.  

Selection of more than one aerodrome is possible when the menu was opened from the 

Weather Messages Window. In this case the “All” button is available and clicking on it 

will select all the aerodromes in the list. 

Clicking on “Ok” will confirm the selection(s) and close the menu. 

 

6.13 CPDLC Emergency Acknowledgement menu 
When a CPDLC emergency message has been received, this menu is used to respond to 

it (if applicable), and then acknowledge the situation. When a reply is required, the 

menu button will read “ROGER”. Left-clicking on it will send the “ROGER” CPDLC 
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message and close the menu. When opening the menu again (or when a reply was not 

required), the button reads “Ack”. Left-clicking on it will acknowledge the emergency. 

The menu is closed when the “ROGER”/“Ack” button is clicked or the cursor leaves the 

menu area. 

 

6.14 CPDLC Pilot Late Acknowledgement menu 
When there is no answer to a CPDLC uplink clearance, this menu can be used to resolve 

the situation. “Abort” discards the uplink and “Manual WILCO” simulates reception of a 

WILCO message. 

 

 

6.15 Time menu 
The Time menu is used to set/change the time value for ATD, CTOT, EAT, EOBT, ETD, 

NBT and NLT fields. Default values are: 

- ATD  current time 

- CTOT  current field value if available, current time otherwise 

- EAT  current field value if available, current time otherwise 

- EOBT  current time 

- ETD  current field value 

- NBT  current field value if available, current time otherwise 

- NLT  current field value if available, current time otherwise 

“C” clears the value, “Ok” sets the time. 

 

6.16 Departure Sequence menu 
The DSQ menu is used to select a specific departure sequence number to a flight. The 

list includes the possible numbers, and the current number is highlighted. Left-clicking 

on a number sets it, “Clear” removes the flight from the departure sequence. 

 Note:   The departure sequence number is only stored locally, it is not sent to other 

controllers or even to other EuroScope instances. 

 

 

 

 

 



49 
 

6.17 GAP menu 
The GAP menu is used to set an approach gap or cancel an existing one. If opened from 

a FAST List row, the gap is for that aircraft only (manual gap), and if opened from the 

FAST Configuration Window, it applies to all new aircraft entered into that sequence 

(systematic gap). 

To set a new gap or change an existing one: 

- Select a value from the list, or enter a custom value to the edit field at the bottom 

(values from 0.1 to 40.0 nm are accepted) 

To cancel an existing gap: 

- Left-click on “CNL GAP” 

 

 

6.18 NFREQ menu 
The NFREQ menu is used to set the “next frequency” value to be sent in datalink 

departure clearances. Left-click on one of the pre-defined values in the list to set it, or 

on the empty area at the bottom to type in a value manually. 
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7 Windows 
The plugin includes a number of windows that are discussed in this chapter. All windows have the following 

common features: 

- Dragging the title bar using the left mouse button will move the window 

- Dragging the box in the bottom right corner with the left mouse button will resize the window  

- Left-clicking the top right corner will close the window 

- Left-clicking the title bar will position the window on the top of other windows 

- Right-clicking the title bar will position the window below other windows 

While resizing the windows always starts from the bottom right corner, it is also possible to resize the 

window to the direction of the top and/or left edges. To do this, continue dragging the bottom right corner 

until the cursor goes past the top or left edge. As all windows have a defined minimum size, nothing will 

seem to happen once you reach the minimum size until the cursor crosses the opposite edge, but then the 

resize operation will continue normally. 

Some windows contain scrollbars to select values or change the items that are displayed: 

- Dragging a scroll bar slider using the left mouse button will move the slider 

- Left-clicking on the scrollbar background area outside the slider will move the slider by a 

predefined amount (in list windows, the view will be scrolled by the number of visible items) 

- Right-clicking on the scrollbar background area outside the slider will position the slider to the 

clicked position 

- Left-clicking on the arrow at the end of the slider will scroll the list by one line 

- The mouse wheel can be used to scroll some scrollbars (most of the ones that have defined steps 

for scrolling, i.e. those with the arrows at the ends) 

Other window-specific mouse function areas are explained below. All functions use the left mouse button 

unless otherwise specified. For each window, the way(s) to open it are listed below the chapter title. 
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7.1 Clock Window 
Global Menu -> time item 

 

The Clock Window displays the current UTC time in HHMM format. 

 

7.2 Brightness Control Window 
Global Menu -> Setup -> Brightness Control… 

 

The Brightness Control Window allows setting the brightness for some screen colors. The “Label” slider 

controls the Concerned, Coordination, Proposition, Assumed and Redundant colors. 
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7.3 CPDLC Setting Window 
Global Menu -> Setup -> CPDLC Setting… 

  

          Main instance    Proxy instances 

The CPDLC Setting Window is used to begin/end the connection to the CPDLC network, and change some 

CPDLC related settings. It is split into three sections: 

Connection setup 

- Login  Four-character callsign used for the CPDLC connection 

- “Connect”/“Online” Left-click to Connect/disconnect the plugin to/from the CPDLC network 

- Logon Code Your personal password to the Hoppie network 

Once a connection has been established, the “Connect” button background color changes to “Information” 

and the button text changes to “Online”. 

 Note:   It is possible to have the Logon Code pre-filled by creating a text file named 

“TopSkyCPDLChoppieCode.txt” in the same folder as the plugin dll (TopSky.dll). The file should 

contain only the logon code, nothing else. As the file contains your personal logon code, do not 

share it. 

If the VATSIM callsign is known when the window is opened, the CPDLC login callsign is pre-selected based 

on it. The CPDLC login comes from a data file, but if not found there and the VATSIM callsign doesn’t end 

with CTR or FSS it will be set to the first part of the VATSIM callsign (which usually is the airport code). If 

necessary, the pre-selected CPDLC login can be changed. 
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DCL/PDC setup 

(only displayed if at least one datalink clearance format has been set up)  

- DCL/PDC Datalink clearance service on/off 

-   [] Auto Automatic sending of datalink clearances on/off 

-       DFREQ Selects how clearances containing a “departure frequency” are handled 

▪ Manual Clearance must be sent manually 

▪ <frequency> This frequency is always sent 

-       NFREQ Selects how clearances containing a “next frequency” are handled 

▪ Default A default frequency (1) is sent 

▪ <frequency> This frequency is always sent 

-       NPT Selects how clearances containing a “next point” are handled 

▪ Manual Clearance must be sent manually 

▪ Default A default point (2) is sent 

-       ADT Selects how clearances containing an approved departure time are handled 

▪ Empty No approved departure time is sent 

▪ EOBT FPL EOBT is sent as the approved departure time 

▪ MDI  “MDI” is sent as the approved departure time 

-       START Selects how clearances containing a start-up approval are handled 

▪ Manual Clearance must be sent manually 

▪ Yes  Start-up is approved 

▪ No  Start-up is not approved 

 

(1) If the aircraft is assumed by you, your primary frequency. If not, the primary frequency of the 

controller whose airspace the aircraft is currently in. If not in any active sector, no frequency is 

available and the clearance must be manually sent. 

(2) The plugin selects the first point in the aircraft’s route that is not part of a SID. If no such point can 

be found, the clearance must be manually sent. 

When the “Auto” option is enabled, a datalink clearance will be automatically sent when a request is 

received if all the following conditions are met: 

- The received clearance request must not contain any remarks text 

- A suitable clearance format is available for the aircraft 

- The aircraft is not assumed by another controller 

- The aircraft has a departure runway assigned 

- The aircraft has a cleared altitude manually assigned 

- The aircraft has a transponder code assigned 

- If the clearance format contains a “departure frequency”, “next frequency”, “next point” or a start-

up clearance item, see the options above for handling. 
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CPDLC setup 

- CPDLC  CPDLC service on/off 

-   [] Auto-accept logon Automatically accepts valid logon requests from tracks above “Min Level” 

The following items are the only ones visible also in proxy EuroScope instances, and are used to determine 

whether sending a clearance via CPDLC is the default setting in some of the plugin menus. For this to 

happen, 

- The aircraft must be above the “Min Level” (FL) specified here 

- The selection button for the menu in question must be on 

- The CPDLC Default Status (in Global Menu->STS) must be “ON” 

When making changes to any items other than the connection setup part and the “DCL/PDC” and “CPDLC” 

selections, the “Ok” and “Cancel” buttons become active. Left-click on “Ok” to apply the changes or 

“Cancel” to abort. 

 

7.4 Raw Video Control Window 
Global Menu -> Setup -> Raw Video Control… 

 

The Raw Video Control Window closes when the mouse cursor leaves the window area. 

The Raw Video Control Window controls the brightness (in general) and afterglow (how fast the radar 

returns fade) of the raw video radar data. 
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7.5 Airspace Management Window 
Global Menu -> AMS -> TSA… 

 

This window is used to control the activation of the areas for the APW and SAP functionality. Each area can 

have start/end times defined for its activation, or it can be activated without any time limits, making it 

active until deactivated manually. The areas can also have lower and/or upper altitude limits. 

An area can have activation rules defined in the area data file. Such areas will be automatically activated 

based on schedule data, NOTAM or AUP contents as long as their “Auto” option is selected (“A” in the 

“Auto” column). The “Auto” option cannot be selected for areas with no activation rules. 

An area’s activation status can be inactive, pre-active or active. A pre-active area is an area in “Auto” mode 

that will become active within a specified time (10min by default) and is shown with “Selected Period” 

color text on a “TSA Preactive” color background. An active area is shown with “Selected Period” color text 

on a “TSA Active” background. The APW system will not alert for a pre-active area, but the SAP system will. 

When the cursor is over the window area, the bottom message area displays automatic map activation 

options depending on the setup. Each one is colored “Arm” if selected off, “Warning” if on but no data 

available, and “Foreground” if on and data available. When the remote option is active, changes to area 

parameters are not allowed. AUP and NOTAM activation can be selected on/off but the data may be 

overridden depending on how the remote data source has been set up. 

The mouse click areas of the Airspace Management Window: 

- Sorting option text (e.g. “Name”) Opens a pop-up menu to select a sorting option for the list 

- Other fields  Left-click to edit field (when edit function active) 

Right-click to open an area pop-up menu 

- “Ok” button  Applies the changes, closes the window 

- “Apply” button  Applies the changes 

- “Cancel” button  Cancels the changes 

- “AUP” label  Toggles area activation based on AUP data 

- “NOTAM” label  Toggles area activation based on NOTAM data 

- “Remote” label  Toggles area activation based on a remote source 

- “Master” label  Toggles saving/uploading area activation data 



56 
 

The sorting pop-up menu contains the following items: 

- Start Date/Time  Sorts based on the Start Date/Time, earliest first 

- Name   Sorts alphabetically based on the Name field 

- Map Text  Sorts alphabetically based on the Map Text field 

The area pop-up menu contains the following items: 

- Activate  Sets start time to current time, clears end time, and sets the 

    area to active state 

- Deactivate  Sets the end time to current time, sets the area to inactive state 

- Auto   If an activation schedule is found in the area data file, sets the 

   area to be activated automatically 

- Edit   Allows to change the area parameters 

- Full Edit  Not implemented 

- Copy   Not implemented 

- Delete   Clears any activation times, returns label and altitude limits to 

their default values and deactivates the area 

With the area pop-up menu opened, the area text row background changes to “Flight Highlight” color. 

After any selection from the pop-up menu other than “Edit”, “Ok”, “Apply” or “Cancel” must be selected to 

apply or cancel the selection. 

With the “Edit” function activated, the following mouse click areas are available for the edited area: 

- Map Text  Set/change/delete the area label text 

- Start Date  Set/change/delete the start date 

- Start Time  Set/change/delete the start time 

- End Date  Set/change/delete the end date 

- End Time  Set/change/delete the end time 

- Lower   Set/change/delete the lower altitude limit 

- Upper   Set/change/delete the upper altitude limit 

- User   Set/change/delete a user defined text 

Dates are shown in the format “yymmdd” and times in “hh:mm” and they must be entered in the same 

format. Entering an empty string for a date will clear it and the related time value and vice versa. When 

entering a time or date value to an empty field, the other value is automatically set to the current 

time/date value. Entering an empty string to the Map Text, Lower or Upper fields will reset the value to the 

default one from the data file. 

Altitudes are shown in hundreds of feet (meters+”m” if metric units chosen) if at or below the transition 

altitude, otherwise in flight levels (meters standard+”m”). They must be entered in the same format. 

After making the changes, click on “Ok”, “Apply” or “Cancel”. For areas with NOTAM-based activity 

periods, the relevant NOTAM identifier is displayed in the “User” field unless a text has been manually 

entered there. A manually entered text may also be displayed in the area label on the radar screen.  
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7.5.1 Area display 

Pre-active and active areas are displayed on the radar screen, depending on the area definition either as 

filled or unfilled polygons. The border and fill colors are defined in the areas data file. 

7.5.1.1 Area label 

An area may display a predefined reduced text label, showing information about the area. By holding the 

left mouse button down on NAME, MAPTEXT or UPPER/LOWER (or on a very small “-” symbol if none of 

them are configured to be displayed for the area), a full area label will be displayed, showing: 

                  NAME 

         MAPTEXT 

 UPPER    USERTEXT 

 ---------    START_TIME - END_TIME 

 LOWER 

- NAME  Area name (not shown by default, must be enabled in plugin settings) 

- MAPTEXT Map text 

- USERTEXT User text string 

- UPPER Upper limit 

- LOWER Lower limit 

- START_TIME Activation start time 

- END_TIME Activation end time 

The reduced label can be configured to display any combination of these fields. In the reduced label, a 

lower limit of “000” will not be displayed. 

If an area has more than one activation period defined, is currently active, and the next activation period is 

pre-active, the levels, times and user text for the next activation period are shown below the current 

activation period in the label (optional feature, can be disabled in the plugin settings). 
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7.6 NAT List Window 
Global Menu -> AMS -> NAT -> NAT List… 

 

The NAT List Window displays information from the downloaded NAT track messages. 

 

7.7 Flight Plan Selection Window 
Global Menu -> FData -> Flight Plan Selection… 

 

The Flight Plan Selection window is used to search for flight plans based on any combination of callsign, 

assigned transponder code and departure airport. All flight plans that are a match with all given 

information will be listed in the Flight Plan Window and can be viewed using its “Prev” and “Next” buttons. 

Clicking “Ok” will do the search and open the Flight Plan Window if it was closed, “Cancel” will clear the 

fields as well as any previously created flight plan list for the Flight Plan Window. 
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7.8 Flight Plan Window 
Global Menu -> FData -> Flight Plan Window… 

Flight Plan Selection Window -> Create a list of one or more flight plans 

Callsign menu -> FPL 

“Open FPL Window” tag function 

 

The Flight Plan Window displays flight plan data as well as some system data related to the flight plan. It 

also allows creating new flight plans and modifying existing ones. The data in the window is not refreshed 

automatically; the time when the data was fetched is displayed in the top left corner. 

The data fields show the following information: 

- C/S  Callsign of the aircraft 

- FRUL  Flight rules (I, V, Y or Z) 

- FTYP  Flight type (not available) 

- NRAC  Number of aircraft 

- ATYP/W Aircraft type and wake turbulence category 

- EQUIP  Equipment list 

▪ For flight plans with FAA equipment codes, a rough conversion to 

ICAO is shown in parentheses 

- ADEP  Departure aerodrome 

- ADES  Destination aerodrome 

- EOBD  Estimated Off-Block Date 
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- EOBT  Estimated Off-Block Time 

- CTOT  Calculated Take-Off Time 

- EQCST  Displays aircraft equipment status for certain equipment (W, Y, U, R, P and S)  

▪ “EQ” equipped, “NO” not equipped, “UN” unknown. 

- TAS  True Air Speed 

- RFL  Requested Flight Level 

- EET  Estimated Elapsed Time 

- ATOW  Actual Take-Off Weight (not available) 

- ALTN  Alternate aerodrome(s) 

- ETD  Estimated Time of Departure 

- ETB  Estimated Time to Boundary (of your sector) 

- RTE  Route 

With the window in extended mode, the following additional information is shown: 

- Other  Flight plan remarks field 

- FMF  Flight Message field 

- SUP  Supplementary information (endurance, PIC name) 

The following system information regarding the flight plan is shown unless the initial plan is displayed: 

- PSSR  Previous SSR code 

- ASSR  Assigned SSR code 

- PEL/CFL Planned Entry Level or Cleared Flight Level, depending on the flight’s state 

- System State System state of the flight plan 

- LFUNC Controller who is currently tracking the aircraft 

- ETN  Estimated time to COPN 

- COPN  Entry coordination point 

- ETX  Estimated time to COPX 

- COPX  Exit coordination point 

- Type  Type of flight plan (APL or FPL) 

- IFPLID  Eurocontrol unique FPL_ID for the flight plan (not available) 

- 0/0  Number of the displayed FPL in the list / total number of flight plans in the list 

For oceanic setups, the following information from the latest received OCM is also available: 

- OCM  Oceanic Clearance Message 

- MNR  Oceanic cruising speed 

- OFL  Oceanic cruising Flight Level 

- NAT  North Atlantic Track name (or “#” for random route) 

- OAN  Oceanic Control Area entry point 

- CTO  Clearance time on OAN 

- “RES”/”no RES” Time restriction indicator in OCM 

The following buttons are available: 

- CRE  Create a new full flight plan (FPL) 

▪ Editable fields will be highlighted 
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▪ If a flight plan is being displayed, all data fields keep their values so a 

new flight plan can be created using an existing one as a base. If not, 

default values will be set to FRUL, NRAC, EQUIP and Other fields 

▪ “Apply” creates the FPL, “Cancel” aborts the operation 

- MOD  Modify the currently displayed FPL 

▪ Available fields will be highlighted 

▪ “Apply” modifies the FPL, “Cancel” aborts the operation 

- Find  Find a flight plan 

▪ Enter Callsign to find the flight plan, “Cancel” aborts the operation 

- Activate Not implemented 

- SAC  Enter a slot time 

▪ Enter the time to the ETD field, “Cancel” aborts the operation 

- Terminate Not implemented 

- CNL  Not implemented 

- RTE  Opens the Complete Route Window 

- Up/down triangle Toggle FPL Window extended mode on/off 

- Send  Not implemented 

- CREAPL Create a new abbreviated flight plan (APL) 

▪ Editable fields will be highlighted 

- MODAPL Modify the currently displayed APL 

▪ Editable fields will be highlighted 

▪ “Apply” modifies the APL, “Cancel” aborts the operation 

- Force  Force this aircraft to be included in the MTCD and SAP processing regardless 

of its sector state or any inhibition settings in the MTCD Status Window 

▪ “Apply” creates the APL, “Cancel” aborts the operation 

- Unforce Cancel the forced inclusion of this aircraft in the MTCD and SAP processing 

- Get SSR Assigns a new SSR code for the flight 

- FSSR  Not implemented 

- MAC  Not implemented 

- Prev  Selects the previous flight plan in the list (see Flight Plan Selection Window) 

- Next  Selects the next flight plan in the list (see Flight Plan Selection Window) 

- Strip  Not implemented 

- INI  View the initial flight plan 

▪ Complete Route Window is closed if it was opened 

▪ Flight plan refresh time and system information will not be shown 

▪ “CRE” starts to create a new flight plan based on the displayed initial 

flight plan, “Refresh” or “Cancel” shows the current flight plan again 

- OCM Tx Not implemented 

- Refresh Refreshes the displayed information 

- Apply  Apply changes that were made 

▪ Any errors will be displayed in the bottom row of the window 

- Cancel Cancel any changes and quit the current operation 



62 
 

In the plugin the only difference between an APL and an FPL is that an APL can only contain the Callsign. If it 

contains any other information (controller-assigned values such as ASSR, CFL, etc. are not taken into 

account), it will be considered to be an FPL. 

For the accepted CFL entry formats, see AFL menu. 

 

7.9 Complete Route Window 
Flight Plan Window -> “RTE” button 

 

Displays the expanded route of the FPL currently shown in the Flight Plan Window. Already passed points 

are shown with “Overflown” color background. Points still ahead show the estimated time over the point 

and the calculated flight level (as calculated by EuroScope) below the point name. 

 

7.10 Create APL Window 
Callsign menu (uncorrelated track only) -> “Create APL” or “IFR APL” item 

 

The bottom area of the window will show status and error messages. 

Enter all the available information (the only required field is the callsign) and click “Ok” to create the APL. 

“Cancel” will clear all the fields. 

If the ASSR field is left empty, a code will be automatically assigned from a dedicated APL code range. If no 

codes are available, an error message will be shown and a code must be manually entered. 

For the accepted CFL entry formats, see AFL menu. 

Left-clicking on the FRUL field toggles the flight rules between “I” (IFR) and “V” (VFR). 

When the APL is created, it is automatically assumed or set as on-contact depending on the plugin setup. 
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7.11 Stack Manager Window 
Holding List… -> “HPT” item 

 

To help with controlling holding aircraft, Stack Manager Windows can be opened. They give a quick look 

into the vertical positions of aircraft that have been given a holding clearance to the holding fix associated 

with the window in question. 

The window is split into three columns: 

- Approaching Hold: Aircraft approaching the holding area 

(more than 5 minutes flying time away from the holding fix) 

- Hold:  Aircraft in the holding area 

- Leave Hold: Aircraft cleared to leave the holding 

The window displays the aircraft at their cleared flight levels. For each aircraft the label contains: 

- Callsign 

- CFL 

- Attitude indicator (“#” in “Warning” color for aircraft without altitude information) 

- EAT 

If there are more than one aircraft with the same CFL, only one callsign will be shown. A “ + ” symbol in 

“SMW Overlap Box” color after the CFL value indicates that there are more flights to be displayed. Clicking 

on the symbol will display a window with all the callsigns with that CFL. 

For each aircraft an altitude box will be drawn that extends from AFL to CFL. Normally the color of the box 

is “SMW Level Band”, but in the Hold and Leave Hold columns if it is closer than 300ft or overlaps any other 

aircraft’s box, the color will be “SMW Overlap”. For an aircraft with a CLAM alert, the box will be in “SMW 

Overshoot” color. A flight level reserved for an overflight is shown in “SMW Overflight” color. The altitude 

box of aircraft in the Leave Hold column extends into the Hold column as well. 

Aircraft will be automatically removed from the Leave Hold column after 10 minutes, but they can also be 

manually removed by right-clicking the callsign. 

Any number of Stack Manager Windows can be opened to monitor multiple holdings at the same time. For 

CFLs at or below the transition altitude, the aircraft label is placed on the numerical value of the CFL, but 

the altitude box is always based on flight levels. 
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The mouse click areas of the Stack Manager Window: 

- Slider or view background area Drag to adjust the lowest shown FL 

- Aircraft callsigns  Open Callsign menu (1) 

- CFLs   Open CFL menu (2) 

- EATs   Open Time menu 

-  +  symbol  Open window to view all callsigns with that CFL 

- FL numbers  Toggle overflight status for that level 

 

1) Right-clicking a callsign in the Leave Hold column immediately removes the aircraft from display 

2) When opened from a Stack Manager Window, the default value in the CFL menu is the current CFL 

regardless of the setting in the Local Settings menu. 
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7.12 CARD (Conflict And Risk Display) 
Global Menu -> Tools -> CARD… 

 

The CARD window presents the MTCD conflicts and conflict risks. It also allows setting some of the related 

parameters. It is divided into two parts: 

On the left is the list area which includes all the detected conflicts and shows the concerned aircrafts’ 

callsigns. The conflict label background is in “Urgency” color for a conflict or potential predicted conflict, 

“Warning” for a risk or potential risk of conflict and “Conflict Ack” for an acknowledged conflict. An 

acknowledged conflict will be automatically de-acknowledged if the predicted minimum separation 

decreases by a predefined amount. 

On the right is the graphical display area that gives an overview to the severity and timeframe for each 

conflict. On the vertical (distance) axis the conflicts are placed to the predicted minimum separation and on 

the horizontal (time) axis the label is placed so that the left edge of the conflict number is at the time of 

closest point of approach. A line in “CARD Time Vector” color, extending to the left from the label, marks 

the time when the separation will decrease below the prediction distance. For fast closure rates the time 

from prediction distance to CPA may be too short to display the line. The conflict labels have the same 

mouse functions as the ones in the list area. If the label position would be outside the maximum time 

displayed in the window, the label is positioned at the maximum displayed time. The area below 5nm 

distance is drawn in “CARD Min Sep” color. 

Conflicts starting earlier than the time marked with the triangle at the bottom of the graphical display area 

are displayed with a dot in the list area label, and with rounded corners of the label in the graphical area. If 

SEP (minimum separation lines) are displayed for the conflict pair, “S” is displayed on the label. Hovering 

the mouse cursor over a conflict label will display the flight legs of the conflict pair on the radar screen. 

The mouse click areas of the CARD window: 

- Sorting option  Opens a pop-up menu to select the sorting option 

o Time loss (time to start of conflict) 

o Time min dist (time to minimum separation) 

o Min dist (minimum separation) 

- “View” menu label  Toggle the View menu 

- Vertical slider  Drag to adjust the distance scale 

- Horizontal slider  Drag to adjust the time scale 

- Diamond on vertical axis Drag to adjust prediction distance 
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- Diamond on horizontal axis Drag to adjust prediction time 

- Triangle on horizontal axis Drag to adjust warning time 

- Conflict labels  Left-click to open Mark/ACK menu 

   Middle-click to display SEP (minimum separation lines) 

    Right-click to remove SEP 

- Conflict callsigns  Middle-click to open Vertical Aid Window 

From the “View” menu it is possible to toggle various MTCD related options: 

- List  Toggles display of the list area 

- Graphic Toggles display of the graphical area 

- Risk  Toggles display of MTCD risks of conflict 

- Downstream Predicted Toggles display of conflicts starting in next sector 

- Potential Predicted Toggles display of MTCD potential predicted conflicts (1) 

- Potential Risk Toggles display of MTCD potential risks of conflict (1) 

- PLC  Toggles display of PLC conflicts (starts later than the triangle displayed on the time axis) 

- MTCD Ind Toggles the display of the MTCD indicator on the track label 

- Notif  Toggles whether tracks in the notified state are considered for MTCD 

- Unco  Toggles whether unconcerned tracks are considered for MTCD 

- Future Toggles future conflicts (starting later than the currently visible time period) 

 

1) The availability of these items in the menu depends on the plugin setup 

From the “Mark/ACK” menu it is possible to toggle conflict-specific options: 

- Mark All Toggles marking the Callsigns and AFL’s of the concerned tracks with “CARD Mark All” color 

- Mark Own Toggles marking the Callsigns of the concerned tracks with “CARD Mark Own” color 

- ACK  Toggles acknowledgement status 

- Address Not implemented 
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7.13 SAP Window 
Global Menu -> Tools -> SAP… 

 

The SAP window lists the aircraft that have SAP conflicts (can be set to also show risks). The list shows the 

following information about each conflict: 

- C/S  Aircraft callsign 

- ASSR  Assigned SSR code 

- AREA  Name of the area 

- USER  User text of the area 

- TIME  Entry time into the area (current time if already inside) 

- CFL  Cleared Flight Level 

- ACK  Conflict acknowledgement status (military coordination indicator) 

For active areas the area name is displayed in “TSA Active” color and for pre-active areas in “TSA Preactive”. 

The mouse click areas of the SAP window: 

- “View” menu label  Toggle the View menu 

o Header Toggle display of list header row 

- “Font” menu label  Opens the Font menu to select the list font size 

- Sorting option  Opens a pop-up menu to select the sorting option 

o Time (entry time) 

o Area (area name) 

- C/S   Left-click opens Callsign menu 

- ASSR   Left-click opens SSR Code menu 

- CFL   Left-click opens CFL menu 

Right-click opens Vertical Aid Window 

- ACK   Left-click toggles military coordination indicator 
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7.14 Vertical Aid Window 
Holding List / SAP Window -> right-click on CFL or XFL item 

Middle-click callsign on CARD  

“Open Vertical Aid Window” tag function 

 

The Vertical Aid Window shows the predicted vertical trajectory of the selected aircraft in “VAW Profile” 

color, starting from its current position (marked with a dot in “VAW Track Position” color), and its MTCD 

and SAP conflicts. The background color of the path area is by default the “Inactive Sector” color, but for 

the time the aircraft is predicted to be inside your sector the color will be the “Active Sector” color with 

“VAW Sector Limits” color edges. 

MTCD conflicts are displayed as boxes horizontally from the start to the end of the conflict and vertically 

from the lowest to the highest level of the conflicting track during that period. The callsign of the conflicting 

track is displayed in the top left corner of the box. The different types of conflicts are shown as follows: 

- Conflict Filled box in “Urgency” color (“Conflict Ack” if acknowledged) 

- Risk  Filled box in “Warning” color (“Conflict Ack” if acknowledged) 

- Other  Unfilled box in “Potential” color (“Conflict Ack” if acknowledged) 

SAP conflicts, if selected to be displayed, are displayed as unfilled boxes in “Warning” color, covering the 

area horizontally from the start to the end of the conflict and vertically from the bottom to the top of the 

area. The area name is shown at the top left corner of the box. 

The mouse click areas of the Vertical Aid Window: 

- “CFL/PEL” button Opens the PEL or CFL menu depending on sector state 

- “View” button Toggles the View menu 

- “XFL” button Opens the XFL menu 

From the View menu it is possible to toggle various MTCD related options: 

- Risk  Toggles display of MTCD risks 

- Notif  Toggles whether tracks in the notified state are shown 

- Unco  Toggles whether unconcerned tracks are shown 

- SAP  Toggles whether SAP conflicts are shown 

For assumed flights, the CFL value is displayed as a “Warning” color horizontal line across the screen if 

different from XFL.  
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7.15 Message In Window 
Global Menu -> Tools -> Message In… 

 

The Message In Window shows received coordination messages, sorted by time, with the newest ones at 

the top of the list. For the ones requiring an answer, it is possible to send it either from this window, the 

aircraft track label or any aircraft list where the relevant items are displayed. The messages will be 

automatically removed from the list when the track becomes Unconcerned, or for some messages, also 

based on a specific event. 

The available message types are: 

- “From <SI> for <Callsign> COF” 

o Displayed when the track is being transferred to you 

o Removed when the transfer is complete or cancelled 

- “From <SI> for <Callsign> ROF” 

o Displayed when the next controller has sent a message requesting the track to be 

transferred to his frequency 

o Left-clicking on the line manually removed it 

o Removed when a transfer is started 

- “From <SI> for <Callsign> HOP [HDG xxx] [DCT xxxxx] [SP xxx]” 

o Displayed when there is a HOP in progress 

o Left-clicking on the line opens the Combined Transfer Menu 

o Removed when the transfer is complete or cancelled 

- “From <SI> for <Callsign> RTI [HDG xxx] [SP xxx] [ARC xx]” 

o Displayed when an RTI message has been received  

- “From <SI> for <Callsign> TIP [HDG xxx] [SP xxx] [ARC xx]” 

o Displayed when a TIP message has been received 

o Removed when the track becomes Assumed 

-  “From <SI> for <Callsign> accept HOP/RTI/TIP” 

o Displayed when an Accept message has been received to HOP, RTI or TIP 

o Left-clicking on the line manually removes it 

- “From <SI> for <Callsign> reject RTI/TIP [by timeout/by system]” 

o Displayed when a reject message has been received to RTI or TIP 

o Left-clicking on the line manually removes it 

-  “From <SI> for <Callsign> RAP/RRV [level] [DCT xxxxx]” 

o Displayed when an entry coordination has been received 

o Left-clicking on a value opens the EuroScope default menu to answer 

o Removed when the track becomes Assumed 

- “From <SI> for <Callsign> CDN [level] [DCT xxxxx]” 

o Displayed when an exit coordination has been received 

o Left-clicking on a value opens the EuroScope default menu to answer an active 

coordination 

- “From <SI> for <Callsign> COD <ASSR>” 

o Displayed when a previous controller assigns a new SSR code for a track 

o Left-clicking on the line manually removes it 
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7.16 Message Out Window 
Global Menu -> Tools -> Message Out… 

 

The Message Out Window shows the coordination messages you have sent, sorted by time, with the 

newest ones at the top of the list. The messages will be automatically removed when the track becomes 

Unconcerned. To manually remove a line, left-click on it. 

The available message types are: 

- “To <SI> for <Callsign> COF” 

o Displayed when you transfer a track 

- “To <SI> for <Callsign> ROF” 

o Displayed when you have sent a ROF message 

- “To <SI> for <Callsign> HOP [HDG xxx] [DCT xxxxx] [SP xxx]” 

o Displayed when you have sent a HOP 

- “To <SI> for <Callsign> RTI [HDG xxx] [SP xxx] [ARC xx]” 

o Displayed when you have sent an RTI message 

- “To <SI> for <Callsign> TIP [HDG xxx] [SP xxx] [ARC xx]” 

o Displayed when you have sent a TIP message 

- “To <SI> for <Callsign> accept HOP/RTI/TIP” 

o Displayed when you have sent an Accept message to HOP, RTI or TIP 

-  “To <SI> for <Callsign> reject RTI/TIP [by timeout/by system]” 

o Displayed when you have sent a Reject message to RTI or TIP. “Rejected by 

timeout” will be sent automatically if the coordination is not answered 

within a specified time. 

- “To <SI> for <Callsign> CDN [level] [DCT xxxxx]” 

o Displayed when you have sent an entry coordination 

- “To <SI> for <Callsign> RAP/RRV [level] [DCT xxxxx]” 

o Displayed when you have sent an exit coordination 

- “To <SI> for <Callsign> COD <ASSR>” 

o Displayed when you have assigned a new SSR code and there is a next 

controller online for the track 
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7.17 Shortcut Window 
Global Menu -> Tools -> Shortcut… 

 

The Shortcut Window gives access to the following functions: 

- Uncoup Labels Toggles uncoupled labels filtering on/off 

- Prim Tracks Toggles primary track filtering on/off 

- Uncont Flights Toggles uncontrolled flight filtering on/off 

- Vector On/Off Toggles all prediction lines on/off 

- Quick Look Toggles function to bypass all filters and show all track labels 

For each of them, when the box is filled, the filter or function is active. 

 

7.18 Microphone Check menu 
Global Menu -> Tools -> CPDLC -> Microphone Check 

 

The Microphone Check menu is used to send a “CHECK STUCK MICROPHONE <frequency>” CPDLC message 

to all CPDLC connected aircraft when a stuck mic is suspected. The menu lists all frequencies selected for 

XMT TXT in EuroScope; left-clicking on one sends the messages. Manual frequency entry is not available. 

The menu closes when a frequency is selected or the cursor leaves the menu area. 
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7.19 CPDLC Current Message Window 
Global Menu -> Tools -> CPDLC -> Current Messages… 

 

The CPDLC Current Message Window displays all sent and received CPDLC messages that have not been 

archived. Each line corresponds to one message, and contains the time the message was sent/received, the 

callsign of the aircraft, a filled triangle (pointing upward for uplink messages, downward for downlink 

messages) and the message text. If the message is too long to fit in the window, “…” is used to mark that 

there is more text in the message. Right-clicking on the message will open a small window that displays the 

entire message. The window will close automatically when the mouse cursor leaves its area. 

The messages (for uplink clearances, also the responses) are color coded to display their status: 

- “Urgency”   CPDLC emergency messages that have not been replied to 

- “CPDLC Failed”   Failed uplink messages 

- “CPDLC Controller Late”  Timed out downlink requests 

- “CPDLC Pilot Late”   Timed out uplink clearances 

- “CPDLC DM Request”  Downlink requests waiting for controller reply 

- “CPDLC UM Clearance”  Uplink clearances waiting for reply 

- “CPDLC Unable”   Uplink clearances replied to with “UNABLE” 

- “CPDLC Standby”   Uplink clearances replied to with “STANDBY” 

- “CPDLC Discarded”   Discarded messages 

- “Foreground”   Other messages 

Left-clicking on the current sorting option opens a popup to select the sorting order: 

- TIME/CS Messages sorted according to send/receive time (default option) 

- DIALOG/CS Messages grouped to dialogues, dialogues sorted by time of first message 

- CS/DIALOG Messages sorted by callsign, messages with same callsign sorted by time 

Left-clicking on a message opens a popup to select some actions for the message: 

- Archive Closes the message dialogue if open, archives all messages in that dialogue 

- Discard Closes the message dialogue and discards all the messages in it 

If the message is “REQUEST LOGON”: 

- ACCEPT Accepts the logon request 

- UNABLE Denies the logon request 

For other messages: 

- Manual Reply Opens a window (see below) to type a free text reply 
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Dialogues are archived automatically 60 seconds after they are closed. The manual “Archive” function may 

be used to archive them earlier if necessary, or if the automatic archiving fails for any reason. 

Always reply to downlink requests using the relevant menu as it ensures correct formatting and type of 

message, and keeps the track label indications correct. The reply options here should only be used when a 

menu cannot be used, for example when the downlink was not parsed correctly and the request is 

therefore not shown on the track label. 

7.19.1 Manual Reply Window 

This window is used to send a manually composed reply to a CPDLC message (max 99 characters). Left-click 

on the area below the “Message text” label to enter the message and select one of the “Expected reply” 

options. Then left-click on “Send” to send the message. 

The window closes automatically when the message is sent or the mouse cursor leaves the window area. 

 Warning:  When replying to a downlink request using the Manual Reply Window, the track label is not 

updated accordingly. If the downlink had been recognized as a request, the request information 

is removed from the label, and if the reply is a clearance, it is not shown on the label, and the 

label values are not updated. Always use the label menus to answer a recognized downlink!  

 

7.20 CPDLC History Message Window 
Global Menu -> Tools -> CPDLC -> History Messages… 

 

The CPDLC History Message Window contains CPDLC messages that have been archived from the CPDLC 

Current Message Window. 
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7.21 Weather Messages Window 
Global Menu -> MET -> Messages… 

 

The Weather Messages Window displays weather related messages. To view the messages, left-click on the 

desired option button (the “LLF” option is not available). 

By default, with the “METAR/SPECI” option button chosen, this window displays the METARs you have 

requested from the VATSIM server (i.e. [F2] <icao>) and any METARs EuroScope requests automatically. 

Whenever a new METAR is received from the server it is added to the list (an old METAR is removed when a 

newer one is received from the same station). New METARs and TAFs are displayed in “Warning” color until 

the mouse cursor is positioned on them (for the decoded METAR, this applies only for the first row). 

Selecting the “SNOWTAM” or “TAF” option will open the Aerodrome menu where the desired stations 

must be selected. If the plugin is configured to use a non-VATSIM METAR source, the stations must be 

selected from a list as well. The messages are automatically updated at specified intervals - the status bar at 

the bottom displays the remaining time to the next automatic update when the mouse cursor is over the 

window area. 

The messages are sorted alphabetically by the station identifier in the list. 

The messages can be viewed in three modes (decoded only available for METARs): 

- List  (the default mode, showing one message per line) 

- Single  (showing only a single message) 

- Single decoded (showing a single METAR in a decoded format) 

 

To view a single message: 

- Left-click on a message in the list 

or 

- Left-click on a decoded METAR 

 

To view a single METAR in the decoded format: 

- Right-click on a METAR in the list 

or 

- Right-click on a single METAR 
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To return to the list view: 

- Left-click on a single message 

or 

- Right-click on a decoded METAR 

 

To remove a METAR/SIGMET/TAF from the window: 

- Display the METAR/SIGMET/TAF in the single or decoded mode 

then 

- Left-click on the “Del” button 

then 

- Left-click “Yes” in the confirmation window that opens (“No” cancels the operation) 

 

7.22 Upper Winds Window 
Global Menu -> MET -> Upper Winds… 

 

The window displays upper winds and temperatures from a range of levels at a user specified position. To 

enter the point, click on the “--N---E” item and enter the position. Acceptable entries are locations defined 

in the active sector file and lat/lon positions in whole degrees (either in the flight plan format or ARINC424 

shorthand, i.e. “60N025E” or “6025E”). 

The “Updated at HH:MM” displays the timestamp of the data downloaded by the plugin (the data itself is 

the forecast for 6 hours after that time). If no time is shown, then no data is available. 
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7.23 Airfield Data Window 
Global Menu -> MET -> Airfield Data… 

 

The window displays the QNH values, transition levels and other information for those airports that have a 

METAR displayed in the Weather Messages Window. The transition level tables are defined in a data file, 

and if a table can’t be found for an airport in the list, a transition level will not be shown. 

The following information is displayed: 

- A/D  Aerodrome ICAO code 

- TIME  METAR timestamp 

- ARWY  Arrival runway (first one if more than one active) 

- QNH  QNH value 

- TL  Transition level 

- TEXT  Other active arrival runways (if more than one) 

TIME, ARWY and TEXT display can be toggled from the “View” menu. 

7.24 General Information Window 
Global menu -> Info -> General Information… 

 

The General Information Window displays basic information on the system state. The following 

functionality is implemented in the plugin: 

- mode  “Free”, “Operational”, “Proxy”, “Replay” or “Training” depending on the 

   connection method 

- role  Own controller ID (between the mode and the “Normal” item) 

- CPDLC Def: [ON|OFF] Displays the state of the CPDLC Default setting 

- FPASD: [ON|OFF] Displays the state of the FPASD setting 
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- Alert functions Status of the alert functions. The function name is shown in “Warning” color if 

   selected off or there’s a fault in the data file. 

- TCT  Displayed if the TCT function is enabled 

- BS  Displayed if the Blind Spot function is enabled 

- A1000  Displayed if plugin is set up to assign the mode S conspicuity code 

- CCAMS Displayed if plugin is selected as the SSR code source 

▪ “Urgency” color if the SSR data file contains no codes 

▪ “Warning” color if simulated traffic is not downloaded 

- FAST  Displayed if the FAST function is enabled 

▪ “Warning” color if AMAN as source and data loading has failed 

 

- IDLS  Plugin is set up to send PDC/DCL. “Warning” color if datalink comms are failed. 

- AGCS  “Warning” color if Hoppie datalink comms are failed 

- MTCD  “Warning” color if prediction time is set to zero 

- SEK  Displayed if plugin is receiving AMAN data. “Warning” color if data loading has failed. 

- SMS  Displayed if FAST function is enabled 

- A-FAST Displayed if FAST function is enabled 

7.25 Miscellaneous Information Window 
Global Menu -> Info -> MISC Information… 

 

The Miscellaneous Information Window is used to browse and search for information in specific data files 

- Aircraft Information about aircraft types 

o Type designator 

o Wake turbulence category 

o Description (Amphibian, Gyrocopter, Helicopter, Landplane, Seaplane or Tiltrotor) 

o Engine count and type (Electric, Jet, Piston, Rocket or Turboprop/turboshaft) 

o Manufacturer and model 

- Locations Information about aerodromes 

o Location indicator 

o Location name 

o (State/Territory) 

- Callsigns Information about aircraft operators 

o Three-letter designator 

o Telephony designator 

o (Aircraft operating agency and notifying state) 
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- Operators Information about aircraft operators 

o Three-letter designator 

o Aircraft operating agency and notifying state 

o (Telephony designator) 

- NAT TrkM Downloaded NAT Track Message (for oceanic setups) 

The information can be filtered using the “Filter” box. The list will only display lines containing the entered 

text string (case insensitive). 

7.26 NOTAM List Window 
Global Menu -> Info -> NOTAM... 

 

The NOTAM List Window displays a list of received NOTAMs. The NOTAMs are retrieved when the window 

is first opened and the list will take a couple of seconds to populate. The NOTAMs are automatically 

updated every two hours. Each NOTAM shows the following information: 

- Location ID (ICAO designator) 

- Serial number 

- Type (“N” = new, “R” = replaces earlier NOTAM, “C” = cancels earlier NOTAM) 

- Abbreviated form of the NOTAM message contents (basic data from the NOTAM header) 

To see the actual NOTAM contents, left-click on a NOTAM line. To return back to the NOTAM list, left-click 

on the single NOTAM. 

By default, the window displays all received NOTAMs. Left-clicking on the “All” label opens a menu where 

the displayed NOTAMs can be filtered by their validity periods. The other available options are “Today” and 

“Tomorrow”. 

7.27 Small QNH/TL Window 
Global Menu -> Info -> Small QNH/TL… 

 

Displays the QNH and transition level for one pre-defined aerodrome. If an aerodrome code has not been 

defined in the settings file, the code will be taken from the login callsign for APP logins and below. For 

CTR/FSS callsigns with no specific aerodrome code defined, the window will automatically close.  
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7.28 LFUNC Frequency Plan Window 
Global Menu -> Info -> LFUNC Frequency… 

 

The LFUNC Frequency Plan Window displays the currently online position-identified controllers and their 

primary frequencies as well as their CPDLC logon callsigns where applicable. The CPDLC information is not 

displayed on proxy instances or when there are no CPDLC stations online. 

 

7.29 Notepad Window 
Global Menu -> MSG -> Notepad… 

 

The Notepad Windows can be used to display any user entered text. Multiple Notepad Windows can be 

opened simultaneously. To enter new text or edit the existing one, click on the window area. The text will 

be automatically wrapped, and if necessary, the “|” character can be used to force a line break. If the 

window is not large enough to fit all the entered text, it will display “…” in the end to indicate that there is 

more information. 

 

7.30 Personal Queue Window 
Global Menu -> MSG -> Personal Queue… 
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The Personal Queue Window displays warning messages related to the plugin’s operation: high priority 

messages informing about potential critical failures in the plugin code, and low priority messages informing 

about faults in the plugin’s external data files or timeout alerts for coordination messages. 

The window currently only displays “ALERT” type messages, and the origin for them is always empty. The 

time field displays the UTC time when the currently viewed message was created. 

The high priority messages are always displayed first. Only when there are no more high priority messages 

in the list, are the low priority ones shown. To acknowledge a message, click on the “ACK” button. This 

removes the message from the list and displays the next one. The “Next” button moves the currently 

viewed message to the back of the list and displays the next message of the same priority. 

 

7.31 ATC Messages Window / Primary Frequency Messages Window 
Global Menu -> MSG -> ATC Messages… / Prim Freq Messages… 

 

These windows display up to 99 last messages transmitted on the relevant text channel (“ATC” or the 

primary frequency). Each message line displays a time stamp, the sender callsign (blank if you) and the 

message itself. 

New incoming messages are displayed in “Warning” color until left-clicked to mark them as read. Left-

double-clicking on any message will mark all messages in the window read. The windows do not resize 

automatically to show all the messages in them, but the number in the title bar shows the total number of 

messages in the window. If the window is not wide enough to fit a complete message, it will display “…” in 

the end to indicate that there is more information. Holding a mouse button down on a message will display 

the entire message.  

  



81 
 

7.32 Safety Nets Status Window 
Global Menu -> STS -> Safety Nets Status… 

 

Allows setting the status for the STCA, MSAW/APM, APW, AIW, TCT and BS systems. The “On/Off” buttons 

control the corresponding system’s status.  

Below them, there are four entry boxes for callsigns to exclude specific callsigns from the specified safety 

nets. The “*” wildcard can be used to match multiple callsigns. It causes all the callsigns that match up to 

the “*” to be a match (i.e. “ABC*” will match all callsigns that start with “ABC”, but “*ABC” will match all 

callsigns as any characters after the “*” will be ignored).  

Below the callsign fields, there are four SSR code boxes that can be used to exclude specific SSR codes from 

the specified safety nets. 

If there are STCA inhibition areas defined in the areas data file, they will be listed in the area in the bottom 

part of the window. The area vertical limits (displayed in 100’s of feet or meters+“m” depending on system 

units) can be edited by clicking on the values, and the area activation can be toggled by clicking on the area 

status. 

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes if any, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 
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7.33 TCT Status Window 
Global Menu -> STS -> TCT Status… 

 

The window contains four entry boxes for callsigns to exclude specific callsigns from TCT. The “*” wildcard 

can be used to match multiple callsigns. It causes all the callsigns that match up to the “*” to be a match 

(i.e. “ABC*” will match all callsigns that start with “ABC”, but “*ABC” will match all callsigns as any 

characters after the “*” will be ignored).  

Below the callsign fields, there are four SSR code boxes that can be used to exclude specific SSR codes. 

If there are TCT areas or TCT inhibition areas defined in the areas data file, they will be listed in the area in 

the bottom part of the window. The area vertical limits (displayed in 100’s of feet or meters+“m” 

depending on system units) can be edited by clicking on the values, and the area activation can be toggled 

by clicking on the area status. 

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes if any, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 
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7.34 Divergence Detection Status Window 
Global Menu -> STS -> Divergence Detection Status… 

 

Allows setting the status for the RAM and CLAM alerting. The “On/Off” buttons control the corresponding 

system’s status. All changes must be applied using the buttons below to take effect. 

- Ok  Applies the changes if any, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 

 

7.35 MTCD Status Window 
Global Menu -> STS -> MTCD Status… 

 

Allows setting the status for the MTCD system. The “On/Off” button controls the system’s status.  

If there are MTCD inhibition areas defined in the areas data file, they will be listed in the area below the 

“On/Off” button. The area activation can be toggled by clicking on the area status. 



84 
 

Below the inhibit areas, there are four SSR code boxes that can be used to exclude specific SSR codes from 

MTCD processing. The entered values must be 2 octal digits, and the system will match codes starting with 

the entered digits (i.e. “20” will match codes 2000-2077). 

Below the SSR codes, there are four ATYP boxes to exclude specific aircraft types. The entered text strings 

must be exact ICAO aircraft type designators (no partial matches or wildcards). 

The flight type inhibit is not available due to network restrictions. 

VFR or IFR flights can be excluded by selecting the respective “Inhibited Flight Rules” button to “On”. 

Finally, there are four entry boxes to exclude specific callsigns. The “*” wildcard can be used to match 

multiple callsigns. It causes all the callsigns that match up to the “*” to be a match (i.e. “ABC*” will match 

all callsigns that start with “ABC”).  

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 

 

7.36 FPCA Status Window 
Global Menu -> STS -> FPCA Status… 

 

The FPCA Status Window displays and allows setting the status for the flight plan conflict areas defined in 

the area data file. 

The area activation can be toggled by clicking on the area status. 

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 
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7.37 FAST Configuration Window 
Global Menu -> STS -> FAST Configuration (opens the Aerodrome menu for airport selection) 

FAST List -> left-click on the area of the menu bar where the MSS and SYS GAP are displayed  

 

The FAST Configuration Window is used to change approach-specific settings. If an approach has more than 

one possible minimum surveillance separation defined, left-clicking on the button in the MSS column cycles 

through them. Left-clicking on the button in the Sys GAP column opens the GAP menu to set up a 

systematic gap to be applied for all new aircraft entered into that approach sequence. Right-clicking 

removes any previously defined gap. 

All changes to the window must be applied using the buttons in the bottom of the window to take effect. 

- Ok  Applies the changes, closes the window 

- Apply  Applies the changes 

- Cancel Cancels the changes 

 

7.38 Runway In Use Window 
Global Menu -> STS -> Runway In Use… (opens the Aerodrome menu for airport selection) 

Radar screen -> middle-click on Airport symbol drawn by the plugin’s “AD_Hotspots” map… 

 

The Runway In Use Window displays the arrival and departure runway allocation at the selected 

aerodrome. Left-clicking on the airport ICAO code opens the Aerodrome menu to select another 

aerodrome. The runway selections are read-only in this window. 

The “RWL Display” button opens the Runway Approach Line Window for this aerodrome. 
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7.39 Runway Approach Line Window 
Global Menu -> STS -> RWY Line Display… (opens the Aerodrome menu for airport selection) 

Radar screen -> right-click on Airport symbol drawn by the plugin’s “AD_Hotspots” map… 

 

The window will open below the mouse cursor, or will be repositioned there if already open.  

The window contains selection buttons to toggle the display of the approach lines for the airport’s runways, 

and a listing of the currently active runways. The “ARR RWL DISPLAY” option toggles the automatic display 

of all approach lines for runways that are selected active for arrival. The setting is global for all airports. 

The options, and their default settings for the approach lines are as follows: 

- OFF  No line drawn 

- NM  16nm line, 5 markers at 2nm intervals 

- NME  30nm line, 5 markers at 2nm intervals, then 4 markers at 5nm intervals 

- Km  30km line, 5 markers at 2km intervals, then 4 markers at 5km intervals 

The color of the line is different depending on whether the runway is active for arrivals or not.  
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7.40 Operations Rate Window 
Global Menu -> STS -> Supervisory -> Operations Rate… 

 

The Operations Rate Window displays the predicted hourly operations rate at a specified airport. The data 

is displayed in 5-minute steps and shown up to 5 hours into the future. The arrival prediction is based on 

aircraft tracks as calculated by EuroScope. The departures are predicted to depart immediately if their 

ground status is set to “DEPA”, earliest in 5 minutes if “TAXI” and earliest in 10 minutes if “PUSH”, with a 

maximum departure rate of one aircraft per minute. 

A number of these windows can be opened to simultaneously view multiple combinations of airport, 

departure/arrival state and runway(s). 

In the area below the title bar, on the left is the ICAO identifier of the airport whose traffic is being 

monitored (a gray label “ICAO” is shown if no airport is selected yet). 

The “Dep” and “Arr” buttons control whether departures and/or arrivals should be shown on the display 

(button background is shown in “Selected” color if selected on). 

The “RWY” label allows entering one or more runway identifiers to filter traffic based on the assigned 

runway. 

The numbers on the right side are the caution and warning limits. The rates are color coded so that a rate 

at or below the caution limit will be shown in “COL Under Threshold” color, a rate above that but at or 

below the warning limit in “COL Above Threshold” and a rate above that in “Urgency”. When both arrivals 

and departures are selected for display, the departures are shown with a hatched color. 

- ICAO  Enter airport identifier 

- Dep  Toggle departures on/off 

- Arr  Toggle arrivals on/off 

- RWY  Enter runways 

- XX / XX Enter caution and warning limits 

- Sliders Change the rate number and time scales 
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7.41 Predicted Traffic Window 
Global Menu -> STS -> Supervisory -> Predicted Traffic… 

 

The Predicted Traffic Window shows the number of aircraft that are predicted to be inside a specified 

controller’s airspace. The data is displayed in 5-minute steps and shown up to 5 hours into the future. The 

prediction is based on the sector ownership and the aircraft tracks are as calculated by EuroScope. 

A number of these windows can be opened to simultaneously view multiple controllers’ situation. In the 

area below the title bar, the left side shows the controller ID whose traffic is being monitored (a gray label 

“ID” is shown if no controller ID is selected yet). Left-click on the text to enter a new ID. If the monitored ID 

is your own, the data area background will be in “Active Sector” color, otherwise in “Inactive Sector”. 

The numbers on the right side are the caution and warning limits. To change them, left-click on them and 

re-enter in the same format (warning can’t be lower than caution; numbers must be separated by a 

forward slash). The traffic numbers are color coded so that a number at or below the caution limit will be 

shown in “COL Under Threshold” color, a number above that but at or below the warning limit in “COL 

Above Threshold” and a number above that in “Urgency”. 

The two sliders change the traffic number and time scales. 
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7.42 Air Traffic Flow Management Window 
Global Menu -> STS -> Flow Management… 

 

The Air Traffic Flow Management Window can be used to list the aircraft flying in the AoR within a specified 

time period. The following options are available to sort and filter the results (the end of the time period is 

the only mandatory item): 

- Sort  The list sorting parameter, click to toggle between ETD and C/S. 

- Time period The start and end of the specified time period 

- Altitude layer The lower and upper limits for the RFL value 

- Known point A point in the filed route 

- Airway An airway in the filed route 

- ADEP  Departure airport (starting with the entered string) 

- ADES  Destination airport (starting with the entered string) 

- Callsign Callsign (starting with the entered string) 

- LFUNC Predicted to enter airspace of this position ID 

- Volumic Sector Not implemented 

For entry into the list, an aircraft must meet all specified filtering criteria. The list displays the following 

information about each aircraft: 

- C/S  Callsign 

- ATYP  Aircraft type 

- ADEP  Departure airport 

- ADES  Destination airport 

- ETD  Estimated Time of Departure 

- RFL  Requested Flight Level 

- FIX  The “Known point” if specified, otherwise the FIR entry coordination point 

- ETO  Estimated time over the fix 

- FCOPX FIR exit coordination point 

- STATE  Flight plan system state 
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The buttons in the window: 

- MOD  Makes the entry boxes and sorting option selectable, clears the list data. 

- Apply  Calculates the data. Available only when MOD has been selected and at least 

   the end of the time period has been entered. If the start of the time period is 

   left empty, the current time is used. 

- Cancel Clears all entries and list data 

 

7.43 Current Operational Load Window 
Global Menu -> STS -> Current Operational Load… 

 

The Current Operational Load Window displays the number of aircraft currently assumed by or flying in the 

airspace of the displayed controllers. The display is refreshed at 60 second intervals. The bars displaying the 

number of aircraft are shown with “COL Under Threshold” color up to a defined number (20 by default), 

and with “COL Above Threshold” above it. The state is displayed as “Normal” unless at least one controller 

has more than the alert number of aircraft, in which case it is displayed as “Warning”. 

 

7.44 Operational Load Forecast Window 
Global Menu -> STS -> Operational Load Forecast… 

 

The Operational Load Forecast Window displays the predicted number of aircraft entering the airspace of 

the displayed controllers within a specified time period. 

- MOD  Makes the start and end of time period boxes selectable for entry. 
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- Apply  Calculates the data. Available only when MOD has been selected and at least 

   the end of the time period has been entered. If the start of the time period is 

   left empty, the current time is used. 

- Cancel Clears all entries and data 

 

7.45 Pre-Departure Clearance Window 
“Open PDC Window” tag function 

“Open DCL Window/PDC Window” tag function (when a datalink clearance has not been requested) 

 

The Pre-Departure Clearance Window is used to adjust clearance data and toggle the clearance flag. The 

following data fields are displayed for review: 

- RWY  Departure runway (left-click to open RWY setup popup list) 

- SID  Assigned SID (left-click to open SID setup popup list) 

- AHDG  Assigned heading (left-click to open AHDG menu) 

- CFL  Cleared level (left-click to open CFL menu) 

- ASSR  Assigned transponder code (left-click to open SSR Code menu) 

The RWY field text is displayed in “Proposition” color if the clearance has not yet been issued and the 

selected runway is not active for departure. The CFL level background is displayed in “Warning” color for 

DEL/GND/TWR/APP/DEP controllers when it is above XFL, and for CTR/FSS controllers when it is above PEL. 

- Ok  Sets the clearance flag, closes the window 

- Cancel Clears the clearance flag, closes the window 

The “Ok” button is active when at least “RWY”, “CFL” and “ASSR” contain data. The window closes 

automatically if the aircraft is assumed by another controller. 
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7.46 Departure Coordination Window 
“Toggle EST/DEP/ABT” tag function (when clearance flag not set and ground state not “DEPA”) 

 

The Departure Coordination Window can be used to set the clearance flag. The window displays the aircraft 

callsign, departure runway, destination and beginning of the route and allows setting the CFL, ASSR and 

EOBT values. 

- CFL  Opens the CFL menu 

- ASSR  Opens the SSR Code menu 

- ATOW  Not implemented  

- EOBT  Opens the Time menu 

- Ok  Applies any changes, sets the clearance flag and closes the window 

- Cancel Disregards any changes, closes the window 

 

7.47 Departure Clearance Window 
“Open DCL Window” tag function (when a datalink clearance has been requested) 

“Open DCL Window/PDC Window” tag function (when a datalink clearance has been requested) 

 

The Departure Clearance Window is used to issue datalink clearances. 

The top part of the window (“From a/c”) displays the aircraft callsign and information received from the 

aircraft in the clearance request message: 
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- Gate  Stand designator 

- ATYP  Aircraft type 

- ADES  Destination 

- ATIS  ATIS designator 

- RCD-RMK Remarks text (only displayed if not empty) 

The bottom part is used to compose and send a reply: 

- RWY * Departure runway  (left-click to open RWY setup popup list) 

- SID  SID designator  (left-click to open SID setup popup list) 

- AHDG  Assigned heading  (left-click to open AHDG menu) 

- CFL * Cleared level   (left-click to open CFL menu) 

- ASSR * Assigned transponder code  (left-click to open SSR Code menu) 

If defined in the clearance data file, the AHDG label may be a toggle button instead. Left-click to toggle 

between “AHDG” and “TRACK”. 

Depending on the setup, one or more of the following fields may also be present: 

- ADT  Approved departure time (left-click to open text entry box) 

- DFREQ * Departure frequency  (left-click to open text entry box) 

- NFREQ * Next frequency  (left-click to open NFREQ menu) 

- NPT * Next route point  (left-click to open text entry box) 

- RMK  Remarks text   (left-click to open text entry box) 

- START  Start-up clearance  (left-click to toggle “YES”/“NO”) 

The buttons are as follows: 

- Send MSG Sends the clearance message, closes the window 

- R/T  Sends a “REVERT TO VOICE” message, aborts the datalink clearance process 

- Cancel Closes the window 

The “Send MSG” button is available when a clearance can be sent – a defined format is available, all 

required fields have been filled (all fields marked with “*” above, when present, are required fields) and 

another controller is not tracking the aircraft (so it’s possible to set the clearance flag). 

 

7.48 Oceanic Time Restriction Window 
“Open Oceanic Time Restriction Window” tag function 

 

The Oceanic Time Restriction Window displays the time restriction(s) contained in the OCM. The window 

closes when the cursor leaves the window area. 
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8 Aircraft lists 

8.1 Sector List 
Global Menu -> Tools -> Flight Plan Lists -> Sector List… 

The Sector List is a EuroScope-style list containing all departed controlled (all IFR, VFR only if ASSUMED) 

aircraft in the following states: 

- Informed  (if corresponding selection made in the Global menu) 

- Concerned (1)  (if corresponding selection made in the Global menu) 

- Coordinated 

- Transfer to me initiated 

- Assumed 

- Transfer from me initiated 

- Redundant  (if corresponding selection made in the Global menu) 

 

1) The display of concerned aircraft is limited to those entering the sector within 60 minutes by default 

 

8.2 Load Factor List 
Global Menu -> Tools -> Flight Plan Lists -> Load Factor List… 

The Load Factor List is a EuroScope-style list containing all departed controlled (all IFR, VFR only if 

ASSUMED) aircraft in the concerned state and all non-departed controlled aircraft in the concerned and 

coordinated states expected to enter the sector within 4 hours by default. 

 

8.3 Resectorisation List 
Global Menu -> Tools -> Flight Plan Lists -> Resectorisation List… 

The Resectorisation List is a EuroScope-style list containing all flights assumed or on-contact with specified 

LFUNCs (controller IDs). 

 

8.4 ETWR List 
Global Menu -> Tools -> Flight Plan Lists -> ETWR List… 

The ETWR List is a EuroScope-style list containing notified and coordinated flights departing from specified 

airports. 

 

 

 



95 
 

8.5 Uncontrolled List 1 
Global Menu -> Tools -> Flight Plan Lists -> Uncont. List 1… 

The Uncontrolled List 1 is a EuroScope-style list containing all or a subset of uncontrolled (VFR flights not in 

ASSUMED state) aircraft, depending on whether filters are set up. 

 

8.6 Uncontrolled List 2 
Global Menu -> Tools -> Flight Plan Lists -> Uncont. List 2… 

The Uncontrolled List 2 is another uncontrolled list to be used if different filtering options are needed. 

 

8.7 Lost List 
Global Menu -> Tools -> Flight Plan Lists -> Lost List… 

The list includes assumed flights that have previously been correlated to a radar track but radar contact has 

been lost. By default, the list opens automatically whenever a flight is added into it, and will be closed 

automatically when empty. If manually opened, the list cannot be manually closed until it is empty. 

 

The lost list contains the following fields: 

Field  Type Left click  Right click 

- C/S  mandatory Open Callsign menu - 

- Lost (time) optional -  - 

- POS (lost position) optional -  - 

- AFL (last received) optional -  - 

- CFL  optional Open CFL menu Open Vertical Aid Window 

- ACF (1) optional Toggle field text color Cancel approach clearance 

- ASSR  optional Open SSR Code menu - 

- FPASD  optional Toggle FPASD track (when globally off) - 

- No  optional -  - 

- ATYP  optional -  - 

- C (local check indicator) optional Toggle local check indicator -  

1) The ACF item is only displayed when its use has been set up in the plugin settings 

“View” opens the View menu: 

- Header Toggle visibility of the list header line 

- Default Sets field visibility to default 

- <field> Toggles field visibility 
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“Font” opens the Font menu to select the list font from three options. 

Filtering the flights entered in the list can be specified in the filtering menu: 

- All FLTs All lost flights will be entered 

- ADES Filter Flights lost within a specified distance from their destinations will not be 

   entered into the list 

The rows are sorted based on “Lost” time in descending order. 

With the plugin set up to automatically open the Lost List when not empty, when a flight is added into the 

Lost List, its FPASD selection is initially set to “on” regardless of the FPASD setting in the Global menu. 

 

8.8 Traffic Management List 1 
Global Menu -> Tools -> Flight Plan Lists -> Traffic Mgt. List 1… 

The Traffic Management List 1 is a EuroScope-style list containing all uncontrolled flights and controlled 

flights at least in coordinated state with specified destinations, and routing via specified points. The ETO 

over the point (or ETA if no point specified) must be within 30 minutes, and the destination must be 

specified to include uncontrolled flights in the list. 

 

8.9 Traffic Management List 2 
Global Menu -> Tools -> Flight Plan Lists -> Traffic Mgt. List 2… 

The Traffic Management List 2 is another traffic management list to be used if different filtering options are 

needed. 
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8.10 Holding List 
The Holding List contains aircraft that have been given a holding clearance (by default the aircraft need to 

be at least in the coordinated sector state). The list is automatically displayed whenever there is at least 

one aircraft in the list. Left-clicking the button at the top right corner collapses the list to display only the 

title bar. 

It is possible to set up point-specific lists using the plugin settings file, in which case the generic list includes 

aircraft that are in a TSA hold, present position hold or holding at a point for which there is no specific list 

defined. For point-specific lists, the list title text begins with the point name. 

 

“View” opens the View menu: 

- Header Toggle visibility of the list header line 

- Default Sets field visibility to default 

- <field> Toggles field visibility 

Left-clicking adjusts only the current list, right-clicking sets the same value to all holding lists. 

“Font” opens the Font menu to select the list font from three options. 

The list sorting option is displayed next to the “View” label. Clicking on it opens a menu to select between 

the following sorting options: 

- EAT/HPT Expected Approach Time -> Holding point name -> Callsign 

- ETO/HPT ETO at the holding point -> Holding point name -> Callsign 

- HPT/CFL/AFL Holding point name -> CFL -> AFL -> Callsign 

- FX/STA Feeder fix name -> Scheduled time at feeder fix -> Callsign 

For point-specific holding lists, the sorting options are “EAT”, “ETO”, “CFL/AFL” and “FX/STA”. 

The ETO column initially displays the estimated time over the holding fix. Once the aircraft enters the 

holding, the displayed time is fixed to the holding start time. For present position holds and holding points 

whose positions are unknown, the time when the holding clearance was given is displayed. 

The holding list contains the following fields: 

Field  Type Left click  Right click 

- Lbl  optional Hide/display track label - 

- C/S  mandatory Open Callsign menu - 

- ASSR  optional Open SSR Code menu - 

- AFL  mandatory Open AFL menu - 

- (attitude indicator) mandatory -  - 

- CFL  mandatory Open CFL menu Open Vertical Aid Window 
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- HPT  optional Open Stack Manager Window - 

- ETO  optional -  - 

- XFL  optional Open COPX Alt popup - 

- COPX  optional Open Waypoint menu Toggle route draw 

- EAT  optional Open Time menu - 

- RT (EAT given indicator) optional Toggle EAT given indicator  - 

- PEL  optional Open COPN Alt popup - 

- FX (1)  optional -  Acknowledge AMAN highlight 

- STA (1) optional -  Acknowledge AMAN highlight 

- TTLTTG (1) optional -  Acknowledge AMAN highlight 

 

1) These fields (feeder fix, scheduled time at fix and time to lose/gain) are available if the plugin has 

been set up to use AMAN data 

If a track label has been hidden, it will be automatically unhidden if the aircraft is cleared to leave the 

holding or an incoming coordination message for the flight is received. 

The expected approach time, if entered, is broadcast to other controllers as well. By default, 10 minutes 

after it a warning message will be entered into the tracking controller’s Personal Queue Window if the 

holding has not been terminated. The EAT is not used for any predictions. The EAT given indicator is not 

transmitted to other controllers. 
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8.11 FAST List 
The FAST List contains aircraft that have been entered into a defined approach sequence. The list is 

automatically displayed whenever there is at least one aircraft in the list. Left-clicking the button at the top 

right corner collapses the list to display only the title bar. 

 

“View” opens the View menu: 

- Header Toggle visibility of the list header line 

- Default Sets field visibility to default 

- <field> Toggles field visibility 

Left-clicking adjusts only the current list, right-clicking sets the same value to all FAST Lists. 

“Font” opens the Font menu to select the list font from three options. 

The list is sorted according to the FSQ field. Aircraft on missed approach are sorted as if they had a 

sequence number of -1 and aircraft already landed as if they had a sequence number of 0. 

On the right side of the menu bar, the current minimum surveillance separation and the systematic gap, if 

any, are displayed for the runway(s). Left-clicking in that area opens the FAST Configuration Window. 

The FAST List contains the following fields: 

Field  Type Left click  Right click 

- FSQ  mandatory Start re-sequence Remove from sequence 

- C/S  mandatory Open Callsign menu - 

- ATYP  optional -  Toggle ATYP highlight 

- W  optional -  Toggle WTC/WTG highlight 

- RWY (FASTRWY) optional Open runway popup list - 

- GAP  mandatory Open GAP menu Remove gap 

- ACF  optional Toggle ACF highlight Cancel approach clearance 

To re-sequence an aircraft behind another, first left-click on the FSQ field of the aircraft to be re-

sequenced. The mouse cursor changes to a cross. Then left-click on the radar position symbol, track label or 

the FSQ field of the aircraft behind which the first aircraft is to be moved. 

To cancel the re-sequence operation, press the ESC key or right-click. 
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9 Keyboard shortcuts 
Some plugin functions can be accessed using a keyboard shortcut. By default, each shortcut is a 

combination of two keys, with the first key needing to be down while the second is pressed to activate the 

function. The available shortcuts and their default keys are: 

- Open FPL Window for the selected flight (1)   <ALT> + <F> 

- Open FPL Selection Window    <ALT> + <E> 

- Start new QDM line     <ALT> + <Q> 

- Remove all QDM lines    <ALT> + <X> 

- Toggle Quick Look function on/off    <ALT> + <U> 

- Display the Flight Leg for the selected flight for 5 seconds (1)  <ALT> + <L> 

- Start a new minimum separation line   <ALT> + <S> 

- Reposition cursor at the center of the radar screen  <ALT> + <C> 

- Toggle a specified map or transfer the selected flight to a defined controller (1) (2) <ALT> + <0>…<9> 

 

1) “Selected flight” means that the mouse cursor is over that flight’s track label 

2) For the map toggle / transfer functions, the desired functionality needs to be set in the plugin 

settings. By default, none of the keys do anything. For example entering “Shortcut_Xfr_Target=2,A” 

and “Shortcut_Map_Target=3,F\M” in the settings would result in <ALT> + <2> initiating a transfer 

to controller ID “A” and <ALT> + <3> toggling the state of map “M” in folder “F”. If the defined map 

doesn’t exist or the controller is not online when the key combination is pressed, nothing happens. 

The following shortcuts are also available but do not have keys specified by default: 

- Toggle upper altitude filter on/off 

- Toggle lower altitude filter on/off 

- Start Find track function 

- Toggle prediction lines globally on/off 

- Toggle Zoom Window 

- Open Maps Window 

- Open Track Control Window 

- Toggle Conflict And Risk Display 

- Toggle Message In Window 

- Toggle Message Out Window 

- Toggle Airspace Management Window 

- Toggle Brightness Window 

- Toggle Personal Queue Window 

- Toggle Shortcut Window 

- Toggle Create APL Window 

- Toggle Uncoupled Labels filter 

- Open Runway Approach Line Window 

- Open new Notepad Window 

- Toggle Airfield Data Window 

It is possible to disable some or all of the shortcuts or adjust the key assignments for each function (to 

define both keys or just a single key) by changing the plugin settings. 

 Warning:  When changing the shortcut keys, care should be taken to avoid problems, as the selected key 

combinations (or single keys) will also be forwarded to EuroScope. If for example <SHIFT>+<A> is 

defined for a shortcut, using it will also enter the capital letter “A” in EuroScope chat.  
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10 Safety Nets 

10.1 AIW (Airspace Infringement Warning) 

10.1.1 General 

The AIW system warns if an uncontrolled aircraft is already inside or going to enter controlled airspace 

within a defined time. The system will only scan correlated radar tracks. 

10.1.2 Alert display 

An alert is shown by displaying the text “AIW” in the ALRT tag item (MSAW and APW alerts will have 

priority over an AIW alert), or in the dedicated AIW tag item. The AFL item is also colored “AIW Intrusion” 

and a one-minute-long prediction line is displayed in “AIW Intrusion” color regardless of the prediction line 

settings. 

 

10.2 APW (Area Proximity Warning) 

10.2.1 General 

The APW system warns if an aircraft is inside or about to enter an active area it shouldn’t be entering (for 

example active danger, restricted and TSA areas). The position of the aircraft is only predicted in 30 second 

intervals for performance reasons so very short future intrusions may not be noticed by the system. The 

areas are defined in an external text file and activated in the Airspace Management Window. 

10.2.2 Alert display 

An alert is shown by displaying the text “APW” in the ALRT tag item (an MSAW alert will have priority over 

an APW alert), or in the dedicated APW tag item. 

 

10.3 MSAW (Minimum Safe Altitude Warning) 

10.3.1 General 

The MSAW system alerts when an aircraft is flying at an altitude below the minimum safe altitude. The 

minimum safe altitude data is read from an external file that has to be present for the system to give any 

warnings. There is an adjustable buffer value in the system that allows some altitude variation below the 

safe altitude to inhibit nuisance alerts for aircraft flying at the minimum safe altitude and not staying 

exactly at that altitude. 

10.3.2 Alert display 

An alert is shown by displaying the text “MSAW” in the ALRT tag item or in the dedicated MSAW tag item. 
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10.4 STCA (Short Term Conflict Alert) 

10.4.1 General 

The STCA system is designed to alert the controller of a possible or actual loss of separation between 

aircraft. The alert is given a specified time (for example 90 seconds) before a loss of separation is predicted 

to happen, but it is dependent on the relative positions and movement of the aircraft. The alert will not be 

shown if both aircraft have STCA alerting inhibited (see the Safety Nets Status Window), are inside 

exclusion areas for parallel approaches, or when either aircraft is inside an active STCA inhibit area. 

In the vertical plane there is an option to always assume that an aircraft will level off at its cleared level. 

This will reduce the number of nuisance alerts caused by climbing and descending aircraft in busy airspace, 

but will delay the alert in case an aircraft continues through its cleared level. The alert will then be given 

only after the failure to level off is seen by the system. 

10.4.2 Alert display 

An alert is shown by coloring the CALLSIGN item background (plugin drawn windows) or the text itself 

(elsewhere where the plugin can’t control the background color) in “Urgency” color. A one-minute-long 

prediction line is displayed in “Urgency” color regardless of the prediction line settings. The radar position 

symbol and history dots are displayed in “Urgency” color. 

An aural alert can also be generated if the corresponding plugin setting is enabled. 

Whenever at least one STCA alert is active, an STCA Alert List is automatically opened. 

 

The list displays for each alert the callsign/FLTID/TSSR of each track, the minimum predicted horizontal 

separation between them, and a checkbox. 

The alerts are sorted by minimum predicted horizontal separation. The list cannot be manually closed, it 

will close automatically when there are no more active alerts. 
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11 Tactical Controller Tool (TCT) 

11.1.1 General 

Tactical Controller Tool works between the STCA and MTCD functions, providing alerts based on the 

aircraft’s tactical trajectory, by default for the next 5 minutes. 

In the lateral plane, the aircraft’s predicted trajectory follows either the planned route, an assigned heading 

clearance, or the current ground track if the aircraft is not found to follow the cleared route/heading. 

In the vertical plane, the predictions use the current level for aircraft maintaining their cleared levels, a 

range of pre-defined vertical speeds for tracks cleared for a vertical maneuver but still in level flight, and an 

uncertainty buffer around the current vertical speed for aircraft climbing or descending. The predictions 

assume the aircraft to level off at its cleared level. 

11.1.2 Alert display 

An alert is shown by displaying the text “TC” (or “TC+” if the aircraft is involved in multiple TCT conflicts) in 

the TCT tag item. The conflict(s) can be visualized by toggling on the TCT legs display using the tag function. 

12 Blind Spot function 

12.1.1 General 

The Blind Spot function alerts the controller for level clearances that would create conflicts, by probing 

specified levels around the aircraft’s current level for conflicts. The function uses by default the TCT 

parameters, but some of the parameters can be specified to be different for Blind Spot. Conflicts starting 

within the next three minutes are displayed. 

12.1.2 Alert display 

The Blind Spot function probes the relevant levels when the CFL Menu is opened, and displays the results 

with colored bars on the right side of the level values. The probe is not refreshed periodically, and as the 

results are valid for only the probed time, they will be flagged as expired (“BS Aged” color) after a specified 

time. For still valid results, the color coding for the probed levels will be: 

- Conflict    BS Warning 

- No conflict, but conflict level(s) between it and AFL BS Crossed Level 

- No conflict, and no conflict level(s) between it and AFL BS No Conflict 

- No calculated data due to probe failure  BS Unknown 
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13 Monitoring Aids 

13.1 CLAM (Cleared Level Adherence Monitoring) 

13.1.1 General 

The CLAM system warns if an aircraft is not maintaining its cleared level and its vertical rate is not towards 

the cleared level. The alert is inhibited when the cleared level is lower than a defined value (100ft), and for 

aircraft in level flight, for a specified time (60 sec) after a new cleared level is set. 

13.1.2 Alert display 

An alert is shown by displaying a “diverging” type aircraft position symbol and the text “L” in the ALRT tag 

item (MSAW, APW and AIW alerts will have priority over a CLAM alert), or in the dedicated CLAM tag item. 

13.2 RAM (Route Adherence Monitoring) 

13.2.1 General 

The RAM system warns if an aircraft is deviating from its route by more than a defined distance (2nm). The 

alert is inhibited specific distances from the departure (30nm) and destination (30nm), and a larger cross-

track error (5nm) is allowed near waypoints where the route makes a turn (over 10° course change). 

For aircraft on a direct-to clearance, the alert is given if the difference between the aircraft’s track and the 

direct track to the cleared point exceeds a set value (5°). After a direct-to clearance is given, the alert is 

inhibited for a specified time (60 sec) or until the aircraft’s track is towards the point, whichever happens 

first. 

13.2.2 Alert display 

An alert is shown by displaying a “diverging” type aircraft position symbol and the text “RAM” in the ALRT 

tag item (MSAW, APW, AIW and CLAM alerts will have priority over a RAM alert), or in the dedicated RAM 

tag item. 
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14 Flight Plan Conflict Probe 

14.1 MTCD (Medium Term Conflict Detection) 

14.1.1 General 

The MTCD system is a tool that enables the controller to predict possible future conflicts between aircraft. 

For performance reasons the maximum selectable look-ahead time (prediction time) is limited to 40 

minutes and the separation distance that triggers the alert (prediction distance) to 20 nm. They can be set 

to any lower value, the defaults being 20 minutes and 8 nm. 

In the lateral plane the system works by checking the aircraft’s predicted route up to the defined prediction 

time and calculating if the separation with other aircraft will be less than the defined prediction distance. 

In the vertical plane, the plugin can be set up to use either of the two following setups (example predicted 

vertical path of a climbing track in black color, relevant levels in grey): 

4D setup (default) 

 

-  Conflicts  (area with red shading) 

o detected within a specified buffer (default 4000ft) around the predicted vertical path of the 

aircraft between AFL and CFL/PEL 

o current clearances may lead to a loss of separation 

-  Conflict risks  (area with yellow shading) 

o detected within the same buffer, but outside of the AFL-CFL/PEL level range 

o current clearances will not lead to a loss of separation, but clearing one of the tracks to 

another level may turn the risk into a conflict 

-  Potential predicted conflicts  (area with light red shading) 

o detected for tracks with equal CFL/PEL values, after the level is calculated to have been 

reached, when the predicted path contains further climb/descent 

o at least one of the tracks must be in the assumed sector state 

o current clearances may lead to a loss of separation if further climb/descent is not given 
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-  Potential risks of conflict  (area with light yellow shading) 

o detected within a larger vertical buffer (default 10000ft) but within the minimum and 

maximum levels of the predicted vertical path 

-  Potential conflicts  (area with light blue shading) 

o detected within the larger vertical buffer, outside of the minimum and maximum levels of 

the predicted vertical path 

Optionally, the detection of potential predicted conflicts and potential risks of conflict can be disabled, 

in which case they will be converted to potential conflicts. 

Level-band setup 

The level-band setup is a simple one that does not take the predicted vertical path of the aircraft into 

account, only the relevant levels. 

 

 

 

 

 

-  Conflicts  (area with red shading) 

o detected for all levels between AFL and CFL/PEL 

o current clearances may lead to a loss of separation 

-  Conflict risks  (area with yellow shading) 

o detected for the whole planned level range outside of the AFL-CFL/PEL level range 

o current clearances will not lead to a loss of separation, but clearing one of the tracks to 

another level may turn the risk into a conflict 

 

For the predictions to be accurate, it’s very important to keep the CFL and the aircraft’s route updated at all 

times. MTCD can be disabled for aircraft that have an assigned heading or a RAM warning, as in those cases 

the system can’t predict the aircraft’s future positions. If it is enabled for them, the system assumes that 

the aircraft continues on its present track and ground speed for a specified time and stops the prediction 

there. The system is always disabled for flight plan tracks with an assigned heading. 

14.1.2 Conflict and risk display 

If there is a conflict or potential predicted conflict for the aircraft within the set warning parameters (can be 

set to warn for risks as well), the following indications are shown. The default values are 10 minutes to loss 

of separation with a 7nm separation minimum. 

- MTCD tag item Either “•” in “Urgency” color or “MTCD” in “Warning” color 

The MTCD conflicts are also displayed in the Conflict and Risk Display and Vertical Aid Window. 
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14.2 SAP (Segregated Area Probe) 

14.2.1 General 

Much like the MTCD system predicts future conflicts between aircraft, the SAP system predicts future 

intrusions into active areas. The system uses the same look-ahead time as the MTCD system. The future 

position predictions are done at one-minute intervals which means a very short intrusion into an active 

area may not be noticed by the system. The classification into risks and conflicts is the same as in MTCD: a 

conflict means that the current clearance may lead to the aircraft entering an active area, whereas a risk 

means that the current clearance will not lead to that but clearing the aircraft to its XFL or some other level 

beyond the current CFL may do so. 

As with MTCD, keeping the CFL and the aircraft’s route updated is important for the system’s operation. 

Like MTCD, SAP can be disabled for any aircraft that has an assigned heading or a RAM warning. If enabled, 

the prediction logic is the same as in the MTCD case. SAP is disabled for non-altitude reporting traffic that 

doesn’t have a manually set AFL. 

14.2.2 Conflict and risk display 

A conflict is shown by displaying the Military coordination indicator (“M”). The indicator can be set to warn 

for risks as well. Note that once the indicator is clicked and changes to inactive state, the system will not 

give further warnings for that aircraft as long as the indicator is in the inactive state. Click on the inactive 

indicator to re-arm the system once the aircraft has passed all the areas for which crossing clearance was 

given. 

SAP conflicts (optionally also risks) are also shown in the SAP Window and Vertical Aid Window. 
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15 Data stored in the flight strip annotation boxes 
The plugin stores some data in the flight strip annotation boxes (the group of nine boxes in three columns 

on the right side of the strip). This enables you to send this data to the next controller, or any other 

controller by manually pushing the strip. EuroScope can be set to automatically push the strip to the next 

controller on handoff. In addition, the plugin automatically pushes the strip when a handoff proposal (HOP) 

is sent. 

The plugin needs to be able to use three of the nine boxes for its functions. They are the boxes marked with 

X’s in the picture below. Do not manually edit those boxes or use them to store any other data. The other 

boxes, marked by minus signs, are currently not used by the plugin in any way. 

     
 - - - 3602 

 - - X 

 X X - 
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16 Known issues 
 

Airport and area hotspots block screen panning 

If you happen to drag one of the airport or area hotspot symbols when trying to move the screen, the 

screen will not move. 

ROF/RTI/TIP message availability limited 

As there is no real plugin-to-plugin communication available, the availability and success of sending the 

ROF, RTI and TIP messages is somewhat limited. 

Problems opening the Radar Menu 

The default method of opening the Radar Menu (<ALT>+right-click) may not always work on Mac hardware. 

It’s possible to adjust the plugin settings to try another combination, but the easiest way is to insert the 

following line to the TopSkySettingsLocal.txt file: 

Shortcut_RadarMenu_Combo=0x00 

The Radar Menu is then opened by right-clicking anywhere on the Global Menu. 
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Appendix 1: Label field descriptions 
 

Treatment of fields with no data  

In the unselected track labels, a data field that contains no data will be blank. An exception to this is the AFL 

field which will display “AFL” when no altitude data is available for the track. In the selected and extended 

track labels a field with no data will still be displayed, usually displaying the field name (for example 

“AHDG”). Exceptions to this are all fields on line 0 and other fields as specified in the label definitions. With 

“List” type items, the display of a field with no data depends on the specific field. 

Active and inactive indicators  

Some of the indicator characters in line 0 of the track label have active and inactive states. In the inactive 

state the indicator is not shown on the unselected label, and on the selected and extended labels it is 

shown after the other indicators and in the normal flight sector color. For example, when clicking the 

Inbound clearance indicator, it changes to inactive state. Clicking the inactive indicator in the selected or 

extended label will restore it to active state. 

Data fields description and coloring  

The table below describes the data fields used in the labels and flight lists and their coloring rules, if 

different from the normal flight sector colors. When the information is relevant to a specific version of the 

item, the version is specified as (version). 

Data field Description Comments Color 

• Frequency “•”, set from Callsign menu (color): Freq Indicator 

• Mark “•”, set from Callsign menu Information 
+ Field 18 / FMF indicator “+” if defined text (by default 

“RMK/” or “STS/”) found in FPL 
remarks field or when FMF is 
not empty 

 

+ Time restriction 
indicator in OCM 

“+” if time restriction 
information is present in OCM 
or has been manually entered 

Non-acknowledged OCM with 
changed restriction: 

- Information 

* Unit “*” if label units are different 
from the system units 

System units set to metric: 
- Warning 

A Manual alerts “A” if Manual alert(s) active Warning 

a Attitude indicator Climbing: up arrow 
Descending: down arrow 
Level flight or unknown: blank 

 

A1000 A1000 warning “1000” when one of the 
conditions in the color column 
are met 

Non-mode S track coupled on A1000: 

- Urgency 
ASSR A1000 and FPL does not 
indicate mode S FLTID capability: 

- Warning 

ACF Approach clearance Approach clearance type: 
Approach: “CA”, 
Visual approach: “VA” 
CAT II approach: “CAT2” 
CAT III approach: “CAT3” 

If toggled on: ACF Via CFL 
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Data field Description Comments Color 

ADEP Departure aerodrome ICAO code, 4 characters  

ADES Destination aerodrome ICAO code, 4 characters If highlighted: Warning 

AFL Actual Flight Level Nautical: 
FL’s          3 digits, 
altitudes “A”+ 2/3 digits, 
heights    “E”+ 2/3 digits, 
in hundreds of feet 
 
Metric: 
FL’s          4/5 digits, 
altitudes “M”+ 4 digits, 
heights    “E”+ 4 digits, 
in tens of meters or meters 
 
The AFL display can be toggled 
to an enhanced display. In this 
state the field displays both the 
flight level and altitude: 
“FL/altitude” (altitude above TRL) 
“altitude/FL” (otherwise) 

AIW: 
- AIW intrusion 

Manually set value: 
- Warning 

Coasted track: 
- Warning 

If highlighted: 
- Warning 

Mark All: 
- CARD Mark All 

S-Highlight: 
- Suite Highlight 



112 
 

Data field Description Comments Color 

AHDG Assigned heading (List): 
- Assigned heading (“H” + 

3 digits) 
- “H” (maintain present heading) 
- “LLZ” (localizer clearance) 
- Direct-to point name 

 
Unselected label: 

- Assigned heading 
- “H” 
- “LLZ” 
- Direct-to point name 

 
Selected label: 

- Assigned heading 
- “H” 
- “LLZ” 
- Direct-to point name 
- SID name if last point 

not yet overflown 
- STAR name if next 

route point belongs to 
the STAR 

- Next point on the route 
 
All except assigned heading are 
settings-file-based features. By 
default “H” and “LLZ” are 
enabled, direct-to point shown 
only if set using the AHDG 
menu or vector and not equal 
to COPX point, SID/STAR/NPT 
are disabled. 
 
If a heading clearance or 
request is in progress via 
CPDLC, displays “[heading]”, 
followed by “+” if the request 
or answer contains a reason 
(i.e. DUE TO something). 
 
(DEP list) does not display the 
brackets for CPDLC status. 

If value assigned and HOP: 
Sent: 

- Proposition Out 
Received: 

- Proposition In 
 
Tactical coordination: 
Sent: 

- Negotiation In 
Received: 

- Negotiation Out 
Rejected: 

- Warning 
Value accepted but not set: 

- Reminder 
 
CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
Downlink message received: 

- CPDLC DM Request 
Controller timeout expired: 

- CPDLC Controller Late 
CPDLC warning raised: 

- Color of the warning 

AIW AIW alert (see also ALRT) “AIW” AIW intrusion 

ALRT Alert message “MSAW”, “APW”, “AIW”, “L” 
(CLAM), “RAM” or “D” (DUPE) 
(in this priority order) 

MSAW and APW: 
- Warning 

AIW: 
- AIW intrusion 

ALT1 Alternate aerodrome 1 ICAO code, 4 characters  
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Data field Description Comments Color 

ALT2 Alternate aerodrome 2 Second alternate can be set by 
inserting “ALT2/XXXX” (where 
XXXX is the aerodrome ICAO 
code) into the FPL remarks field 

 

AN Area navigation “P” if RNAV1 capable, 
“R” if RNAV5 capable 

 

APW APW alert (see also ALRT) “APW” Warning 

ARC Assigned vertical rate Nautical: 
“R” + 2 digits, in 100’s of ft/min 
 
Metric: 
“R” + 2 digits, in m/s 
 
(followed by “+” or “-” when 
applicable for a minimum or 
maximum rate clearance) 

If value assigned and HOP: 
Sent: 

- Proposition Out 
Received: 

- Proposition In 
 
Tactical coordination: 
Sent: 

- Negotiation In 
Received: 

- Negotiation Out 
Rejected: 

- Warning 
Value accepted but not set: 

- Reminder 

ARWY Arrival runway Arrival runway identifier If manually assigned: Rwy Locked 
(optional feature) 

ASI Assuming sector   

ASP Assigned speed Mach “M”+ 2 digits, 
in 1/100’s of Ma 
 
“HS” for high speed clearance 
 
Nautical: 
Speed  2 digits, in 10’s of knots 
 
Metric: 
Speed “K”+ 2 digits, in 10’s of km/h 

 
(followed by “+” or “-” when 
applicable for a minimum or 
maximum speed clearance) 
 
If a speed clearance or request 
is in progress via CPDLC, 
displays “[speed]”, followed by 
“+” if the request or answer 
contains a reason (i.e. DUE TO 
something). 

If value assigned and HOP: 
Sent: 

- Proposition Out 
Received: 

- Proposition In 
 
Tactical coordination: 
Sent: 

- Negotiation In 
Received: 

- Negotiation Out 
Rejected: 

- Warning 
Value accepted but not set: 

- Reminder 
 
CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
Downlink message received: 

- CPDLC DM Request 
Controller timeout expired: 

- CPDLC Controller Late 
CPDLC warning raised: 

- Color of the warning 
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Data field Description Comments Color 

ASSR Assigned mode 3/A 
code 

4 digits or “A”+ 4 digits. 
 
If no code assigned, shows TSSR 
code if available (optional 
feature, always disabled in (DEP 
list) ) 
 
If a SQUAWK SSR message is in 
progress via CPDLC, displays the 
code in brackets, followed by 
“+” of the answer contains a 
reason (i.e. DUE TO something). 
 
(DEP list) does not display the 
brackets for CPDLC status. 

If different than TSSR: 
- Information 

(in (DEP list), regardless of actual 
radar coverage) 
 
CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
CPDLC warning raised: 

- Color of the warning 

ATD Actual Time of 
Departure 

UTC time in “HHMM” format  

ATIS ATIS designator   

ATYP Aircraft type Type with max 4 characters If highlighted: Warning 

ATYP/W Aircraft type / Wake 
Turbulence Category 

Type with max 4 characters + 
“/” + WTC (“L”, “M”, “H”, “J” or 
“?”) 

If highlighted: Warning 

C Inbound clearance “C” if ADES is one of the 
defined airports -> aircraft 
needs inbound clearance 

Active state: Information 
 

CALLSIGN Callsign If label is minimized, prefixed by 
“<”. 
 
If number of aircraft is more 
than one, suffixed by “+”. 
 
If correlated to a primary track 
or to a secondary track with no 
ASSR code and a non-discrete 
TSSR code, suffixed by “*”. 
 
If the flight is CPDLC connected, 
the callsign is displayed in 
brackets. 

Priority order: 
STCA alert: Urgency 
HOP received: Proposition In 
Transfer in: Assumed 
HOP sent: Assumed 
Transfer out: Redundant 
Level band highlight AFL: Urgency 
Level band highlight XFL: Warning  
Mark Own: CARD Mark Own 
Highlight: Warning 
Mark All: CARD Mark All 
S-Highlight: Suite Highlight 
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Data field Description Comments Color 

CFL Cleared Flight Level See AFL field for number format. 

 
Approach clearance displayed if 
the use of ACF item is not set up. 

 
Unselected label: 
Not shown if equal to AFL 
 
If a level clearance is in progress 
via CPDLC, displays “[level]”, 
followed by “+” if the answer 
contains a reason (i.e. DUE TO 
something). 
 
(DEP list) does not display the 
brackets for CPDLC status. 

(DEP list): 
for CTR or FSS if CFL > PEL, 
for others if CFL > XFL: 

- Warning 
 
(all versions): 
CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
CPDLC warning raised: 

- Color of the warning 

CFL/PEL Cleared Flight Level or 
Planned Entry Level 

PEL is shown for flights in 
“coordinated” and “ongoing 
coordination” states, CFL 
otherwise.  
 
See AFL field for number format. 

 
Approach clearance displayed if 
the use of ACF item is not set up. 

 
Unselected label: 
PEL:  Not shown if equal to AFL 

and no ongoing 
coordination. 

CFL:  Not shown if equal to AFL 
 
If a level clearance is in progress 
via CPDLC, displays “[level]”, 
followed by “+” if the answer 
contains a reason (i.e. DUE TO 
something). 

PEL: 
Coordination sent: 

- Proposition Out 
Coordination received: 

- Proposition In 
Change just before ETN: 

- Info Coord 
Coordination refused: 

- Warning 
 
CFL: 
CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
Downlink message received: 

- CPDLC DM Request 
CPDLC warning raised: 

- Color of the warning 

CLAM CLAM indicator (see also ALRT) “L” Warning 

CLR Clearance received flag If clearance not received: 
(long): blank, (short): “¬” 
 
If clearance received: 
(long): “OK”, (short): “¤” 
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Data field Description Comments Color 
CLR/DCL/CMT Combined clearance 

received flag, DCL 
dialogue status and 
CMT Text indicator 

Clearance received flag set 
manually: 

- “OK” 
otherwise, state of the datalink 
clearance dialogue (if any): 

- “RCD” (request received) 
- “SENT” (clearance sent) 
- “DONE” (ack received) 
- “R/T” (r/t sent) 
- “FAIL” (failed) 

 
(“RCD•” and “R/T•” indicate 
remark text present in the RCD)  

If “RCD” or “RCD•”: Warning 

CLR/DCL/CMT 
(short) 

Combined clearance 
received flag and DCL 
dialogue status 

Clearance received flag set: 
- “¤” 

State of the datalink clearance 
dialogue: 

- “R” (request received) 
- “S” (clearance sent) 
- “F” (failed) 

Clearance flag not set: 
- “¬” 

 
(“R” alternates with “•” if 
remark text present in the RCD) 

If “R” or “•”: Warning 

CMT CMT Text indicator “•” if received RCD contains 
remark text 

 

CODE FPL mode S hex code “/” + aircraft’s mode S hex code 
if found in the FPL remarks 

 

COM Communication type “r” if voice receive only 
“t” if text only 

Warning 

COMP_CS ICAO RTF callsign The decoded ICAO RTF callsign 
(“???” if not in database) 

 

COORD Coordination message ROF message sent/received: 
- “ROF” 

 
Transfer with release: 

- “F” fully released 
- “C” released for climb 
- “D” released for descent 
- “T” released for turns 

Sent: 
- Proposition Out 

Received: 
- Proposition In 

 
(until assumed by the 
downstream position) 

COPN Entry point  Coordination sent: 
- Proposition Out 

Coordination received: 
- Proposition In 

Coordination refused: 
- Warning 
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Data field Description Comments Color 

COPX Exit point (DEP list): 
If logged in as CTR and flight not 
inside active sector, displays 
COPN 
 
(with holding): 
A holding clearance is displayed 
if there is no coordination. It 
shows the holding point name + 
“ H” or for lat/lon point 
holdings, “POS   H”. 
For a TSA Hold clearance, the 
area name is shown. 

Coordination sent: 
- Proposition Out 

Coordination received: 
- Proposition In 

Coordination refused: 
- Warning 

COPN/COPX Entry point or Exit point COPN is shown for flights in 
“coordinated” and “ongoing 
coordination” states, 
COPX in “assumed”, “transfer 
initiated” and “redundant” 
phases. 
 
(with holding): 
A holding clearance is displayed 
if there is no coordination. It 
shows the holding point name + 
“ H” or for lat/lon point 
holdings, “POS   H”. 
For a TSA Hold clearance, the 
area name is shown. 

Coordination sent: 
- Proposition Out 

Coordination received: 
- Proposition In 

Coordination refused: 
- Warning 

CPDLC_E CPDLC Emergency CPDLC emergency messages: 
“SQ7500”, 
“[MAYDAY]”, or 
“[PAN]” 

Urgency 
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Data field Description Comments Color 

CPDLC_W CPDLC Warning CPDLC warning messages: 
“CPDLC FAIL” 

- network failure 
“CPDLC P ABT” 

- pilot logoff 
“<type> ERR” 

- message failure 
“<type> NOT CDA” 

- NOT CURRENT DATA 

AUTHORITY response 
“<type> P LATE” 

- pilot timeout 
“<type> SBY” 

- STANDBY response 
“<type> UNA” 

- UNABLE response 
“CPDLC MSG” 

- unidentified downlink 
 
<type> is the type of message: 
“AHDG” 

- heading clearance 
“CFL” 

- level clearance 
“COF” 

- communication transfer 
“DCT” 

- direct-to clearance 
“SQI” 

- SQUAWK IDENT message 

“SSR” 
- SQUAWK SSR message 

“VCI” 
- communication transfer 

“CPDLC FAIL”, 
“CPDLC P ABT”, 
“<type> ERR” or 
“<type> NOT CDA”: 

- CPDLC Failed 
 
“<type> P LATE”: 

- CPDLC Pilot Late 
 
“<type> SBY”: 

- CPDLC Standby 
 
“<type> UNA”: 

- CPDLC Unable 
 
“CPDLC MSG” 

- CPDLC DM Request 
 

CRC Computed vertical rate Nautical:   2 digits, in 100’s of ft/min 

 
Metric:      2 digits, in m/s 
 
(with sign): 
value preceded by 

- “C” for climbing 
- “D” for descending 

 

CTO Clearance time on OAN “HHMM” Major difference between 
estimated time at point and CTO: 

- Urgency 
Minor difference between 
estimated time at point and CTO: 

- Warning 
Non-acknowledged OCM with 
changed CTO: 

- Information 
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Data field Description Comments Color 

DBPS Downlinked barometric 
pressure setting 

Barometric pressure setting as 
downlinked via mode S DAPs. 
Not available on VATSIM. 

 

DCL DCL dialogue status State of the datalink clearance 
dialogue (if any): 

- “RCD” (request received) 
- “SENT” (clearance sent) 
- “DONE” (ack received) 
- “R/T” (r/t sent) 
- “FAIL” (failed) 

If “RCD”: Warning 

DGS Downlinked ground 
speed 

Ground speed as downlinked 
via mode S DAPs. Format as in 
GS field. 

 

DHDG Downlinked heading Magnetic heading as 
downlinked via mode S DAPs. 
“H” + 3 digits. 

 

DIAS Downlinked indicated 
airspeed 

Indicated airspeed as 
downlinked via mode S DAPs. 
Not available on VATSIM. An 
estimated value is displayed if 
upper wind/temp data is 
available. 

 

DMACH Downlinked Mach 
number 

Mach number as downlinked 
via mode S DAPs. Not available 
on VATSIM. An estimated value 
is displayed if upper wind/temp 
data is available. 

 

DRC Downlinked rate of 
climb/descent 

Rate of climb/descent as 
downlinked via mode S DAPs. 
Not available on VATSIM 
(computed rate displayed 
instead, see CRC (with sign) ). 

 

DRWY Departure runway Departure runway identifier If manually assigned: 
- Rwy Locked 

 
(DEP list): 
Clearance flag not set: 

- Proposition In 
Clearance flag set: 

- Information 

DSFL Downlinked selected 
flight level 

Selected flight level as 
downlinked via mode S DAPs. 
Not available on VATSIM. 

 

DSQ Departure sequence 
number 

  

DUPE DUPE indicator 
(see also ALRT) 

“D” Warning 

EAT Expected Approach Time Manually entered time in 
“HHMM” format 

 

EET Estimated Elapsed Time “HHMM”  
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Data field Description Comments Color 

EMRG Emergency “HI” for squawk 7500, 
“CF” for squawk 7600, 
“EM” for squawk 7700 

Urgency 

EQUIP FPL equipment field (COM/NAV): 
- COM/NAV equipment 

(SUR): 
- “/” + surveillance equipment 

 

If the FPL equipment is in the 
FAA format, a rough conversion  
to the ICAO format is made 

 

EST/DEP/ABT Manual departure Clearance flag not set: 
- “EST” 

Clearance flag set: 
- “DEP” 

Departed: 
- “ABT” 

 

ETA Estimated Time of Arrival UTC time in “HHMM” format or 
“HOLD” if flight in holding state 

 

ETD Estimated Time of Departure UTC time in “HHMM” format  

ETD/ATD Estimated Time of 
Departure or Actual 
Time of Departure 

Not departed: 
- ETD 

Departed: 
- ATD 

 
“HHMM”, both times taken 
from the FPL data 

 

ETN Estimated time over 
COPN or sector entry 
time if no COPN 

UTC time in “HHMM” format 
 
(sector entry): always entry time 

 

ETOHP Estimated time over 
holding point or holding 
start time 

UTC time in “HHMM” format  

ETX Estimated time over 
COPX or sector exit 
time if no COPX 

UTC time in “HHMM” format 
 
(sector exit): always exit time 

 

F No fix warning “F” if IFR flight is not routing via 
one of specified fixes to its 
destination 

Information 

FASTRWY FAST runway Arrival runway identifier, if not 
the first runway in a DPA setup 

 

FASTwarn FAST warning “SQ” for sequence warning Warning 

FCOPN FIR COPN point FIR entry coordination point  

FCOPX FIR COPX point FIR exit coordination point 
 
For inbound and domestic 
flights, displays ADES. 

If different from OCM entry point: 

- Information 

FETN Estimated time over FCOPN   

FETX Estimated time over FCOPX   

FF Feeder fix AMAN feeder fix name If highlighted: AMAN Data Highlight 
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Data field Description Comments Color 

FIELD15 Speed/Level/Route The flight plan field 15 data 
(TAS, RFL and route). Max 540 
characters 

 

FIELD18 Other information The flight plan field 18 data 
(remarks). Max 360 characters 

 

FLTADD Mode S transponder address Mode S transponder hex address  

FLTID Aircraft identification Callsign as received via mode S  

FLTID/TSSR Aircraft identification or 
transponder code 

FLTID if available, otherwise 
TSSR 

If highlighted: Warning 

FMF Flight Message Field User entered text, 
stored only locally 

 

FSQ FAST sequence number Sequence number or “MA” for 
missed approach 

If sequence warning or missed 
approach: Warning 
If arrival runway is not set as 
active for arrivals: FSQ SI 

FText Free text   

GS Ground Speed Nautical:       3 digits, in knots 
(optionally prefixed by “N”) 
 
Metric:          “K”+ 3 digits, in km/h 

If highlighted: Warning 

HOLD Hold/XHold Holding clearance state at point 
related to the traffic 
management list 

Warning 

HPT Holding point Holding point name or for 
lat/lon point holdings, “POS”. 
For a TSA Hold clearance, the 
area name is shown. 

 

I Flight information “I” if OP_TEXT has data  

Label Label hidden flag “¤” if label displayed, 
“¬” if label hidden 

 

M Military coordination “M” if military coordination is 
required 

Active state: Warning 

MALRT Manual alerts Displays alerts entered via the 
Callsign menu 

Warning 

MFX Metering fix AMAN metering fix name If highlighted: AMAN Data Highlight 

MFX_FF Metering fix or 
feeder fix 

AMAN metering fix or 
feeder fix name 

If highlighted: AMAN Data Highlight 

MNR Oceanic cruising speed Cleared cruising speed from the 
last received OCM 

Non-acknowledged OCM with 
changed MNR: 

- Information 

MSAW MSAW alert (see also ALRT) “MSAW” Warning 

MTCD MTCD indicator (dot): “•”, (text): “MTCD” 
if aircraft has an MTCD problem 

(dot):  Urgency (Conflict Ack if all 
conflicts acknowledged) 

(text): Warning 
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Data field Description Comments Color 

N/ATYP Number of aircraft / 
Aircraft type 

Unselected label: 
Number range 2 - 99 
 
Selected label or (List): 
Number range 1 - 99 
 
Number can be set by prefixing 
the aircraft type in the FPL by 
“X/” where X is the number 
(max 99) 

If highlighted: Warning 

NAT North Atlantic Track 
name 

Cleared NAT name from the last 
received OCM (“#” for a 
random route) 

Non-acknowledged OCM with 
changed NAT: 

- Information 

NBT Not Before Time Time restriction at OAN Non-acknowledged: Warning 

NFREQ Next frequency Next frequency for a departing 
aircraft, to be sent in DCL 

 

NLT No Later than Time Time restriction at OAN Non-acknowledged: Warning 

NPT Next route point When a DCT request or 
clearance via CPDLC is in 
progress: 
Displays the point name 
followed by “+” if the request 
contains a reason (i.e. DUE TO 
something) 
 
Otherwise: 
Next point on the route 

CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
Downlink message received: 

- CPDLC DM Request 
Controller timeout expired: 

- CPDLC Controller Late 
CPDLC warning raised: 

- Color of the warning 

NRAC Number of aircraft Number from 2 to 99 
 
Extended label:            “n” if 1 
Other label or (List):    blank if 1 
 
Number can be set by prefixing 
the aircraft type in the FPL by 
“X/” where X is the number 
(max 99). 

 

NSSR SSR warning Displays ASSR if different from 
TSSR 
(always displayed for flight plan 
tracks or when SQUAWK SSR 
CPDLC message has been sent) 

CPDLC: 
Uplink message sent: 

- CPDLC UM Clearance 
CPDLC warning raised: 

- Color of the warning 

O Oceanic alert “O” if Oceanic Clearance 
Message is not acknowledged 

Warning 

OAN Cleared Oceanic 
Control Area entry 
point 

Cleared entry point from the 
last received OCM 

Non-acknowledged OCM with 
changed OAN: 

- Information 

OCM Oceanic Clearance 
Message 
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Data field Description Comments Color 

OFL Oceanic cruising Flight 
Level 

Cleared oceanic flight level 
from the last received OCM 

Non-acknowledged OCM with 
changed OFL: 

- Information 

OP_TEXT Flight information 
message 

User entered text  

OP_TEXT2 OP_TEXT2 message User entered text, 
stored in the scratchpad 

 

P No P-RNAV/RNAV1 
capability 

“P” if aircraft equipment is not 
indicating P-RNAV/RNAV1 
capability and destination 
airport is in a pre-defined list 

Not equipped: 
- Information 

Unknown: 
- Unknown 

PEL Planned Entry Level See AFL field for number format. 

 
Approach clearance displayed if 
the use of ACF item is not set up. 

 

Coordination sent: 
- Proposition Out 

Coordination received: 
- Proposition In 

Change just before ETN: 
- Info Coord 

Coordination refused: 
- Warning 

PFREQ Pilot monitored frequency Displays your primary 
frequency when transfer of 
communications was done via 
CPDLC using the MONITOR 
option 

CPDLC DM Request 

PRFL RFL requested by pilot 
via CPDLC 

Displays “[requested level]”, 
followed by “+” if the request 
contains a reason (i.e. DUE TO 
something) 

CPDLC: 
Downlink message received: 

- CPDLC DM Request 
Controller timeout expired: 

- CPDLC Controller Late 
CPDLC warning raised: 

- Color of the warning 

PSSR Previous mode 3/A 
code 

If not known, shows ASSR if 
available. Format as ASSR field. 

 

R No B-RNAV/RNAV5 
capability 

“R” if aircraft equipment is not 
indicating B-RNAV/RNAV5 
capability 

Not equipped: 
- Urgency 

Exempted: 
- Information 

Unknown: 
- Unknown 

RAM RAM indicator (see also ALRT) “RAM” Warning 
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Data field Description Comments Color 

RFL Requested Flight Level See AFL field for format 
 
(List): 
If an RFL request is in progress 
via CPDLC, displays “[requested 
level]”, followed by “+” if the 
request contains a reason (i.e. 
DUE TO something). 
 
(DEP list) does not display the 
brackets for CPDLC status. 

(List) and (DEP list): 
CPDLC: 
Downlink message received: 

- CPDLC DM Request 
Controller timeout expired: 

- CPDLC Controller Late 
CPDLC warning raised: 

- Color of the warning 

ROUTE Flight plan route (DEP list) 
-  part 1 shows first 15 characters,  
   part 2 characters 16-30 
 
If departing from defined 
airports: 
-  first 30/45 characters (2 or 3 parts) 

If arriving at a clearance flag 
airport: 
-  last 30/45 characters (2 or 3 parts) 

Else: 
-  first 30/45 characters (2 or 3 parts) 

 

RT EAT given indicator EAT not given to pilot: “¬” 
EAT given to pilot: “¤” 
 
(local flag only, not sent to 
other controllers) 

 

S Mode S mismatch 
indicator 

“S” if downloaded callsign is 
different than coupled flight 
plan callsign 

Warning 
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Data field Description Comments Color 

SI Sector Indicator Assumed track: 
Next sector identifier or 
frequency. Displayed in 
brackets if a communications 
transfer is in progress via 
CPDLC, followed by “+” if the 
answer contains a reason (i.e. 
DUE TO something). The 
frequency display is forced on 
during a transfer via CPDLC. 
 
Other tracks: 
Tracking controller identifier or 
frequency. 
 
(List): 
frequency display is not 
possible 
 
(DEP list) does not display the 
brackets for CPDLC status. 
 
(Current) displays always the 
current tracking controller id 
 
(Previous) displays the current 
tracking controller id unless it is 
you or the track is in redundant 
state 
 
(Next) displays the next 
controller id when assumed, or 
current when in redundant 
state 

Priority order: 
HOP sent: 

- Proposition Out 
Transfer initiated: 

- Redundant 
Next unit coordination received: 

- Proposition In 
Manually changed next sector: 

- Warning 
Normal next sector: 

- Coordination 
 
CPDLC: 
Communications transfer 
message sent:  

- CPDLC UM Clearance 
CPDLC warning raised: 

- Color of the warning 

SID Assigned/planned SID SID identifier New assignment: Sid Star Allocation 
(optional feature) 

SQ Arrival sequence number 
(manually set) 

A number from 1 to 50   

SQ_AMAN Arrival sequence number 
(provided by AMAN) 

A number from 1 to 99   

STAB Arrival stability Empty, or one of the following: 
- UNSTABLE 
- STABLE 
- SUPERSTABLE 
- FROZEN 

 

STAFF Scheduled Time of 
Arrival at feeder fix 

AMAN calculated time to pass 
the feeder fix 

If highlighted: AMAN Data Highlight 

STAR Assigned/planned STAR STAR identifier New assignment: Sid Star Allocation 
(optional feature) 
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Data field Description Comments Color 

STATE Current system state Notified: NOTI 
Coordinated: COOR 
On-going coordination: ONGC 
Assumed: ASSU 
Transfer initiated: TRAN 
Redundant: REDU 
Terminated: TERM 
Free: FREE 
On-contact: ONCT 

 

STS Ground state EuroScope default ground state  

TAS Flight Plan TAS TAS from flight plan, either: 
“K” + 4 digits, km/h 
“N” + 4 digits, knots 
“M” + 3 digits, 1/100’s of Ma 

 

TCT TCT indicator “TC”   if track is involved in one 
           TCT conflict, 
“TC+” if in more than one 
 
Unselected label: 
Not displayed if track is subject 
to an STCA alert 

TCT Warning 

TEXT2 OP-TEXT2 message If more than 10 characters, 
shows first 9 + “>” 

 

TRACK Ground track “T” + the aircraft’s current 
ground track in degrees 
(true): true 
(magnetic): magnetic 

 

TOM Time of Metering AMAN calculated time to pass 
the metering fix 

If highlighted: AMAN Data Highlight 

TOM_STAFF Time of Metering or 
Scheduled Time of 
Arrival at feeder fix 

AMAN calculated time to pass 
the metering fix or feeder fix 

If highlighted: AMAN Data Highlight 

TSSR Aircraft transponded 
mode 3/A code 

4 digits or “A”+ 4 digits  

TTL_TTG Time To Lose/Gain at 
metering fix 

 If highlighted: AMAN Data Highlight 

TTLTTG_FF Time To Lose/Gain at 
feeder fix 

 If highlighted: AMAN Data Highlight 

TTLTTG_MFX_FF Time To Lose/Gain at 
metering fix or feeder fix 

 If highlighted: AMAN Data Highlight 

V Flight rules “V” if VFR, 
“Y” if first IFR and later VFR, 
“Z” if first VFR and later IFR 

 

W No RVSM capability “W” if aircraft equipment is not 
indicating RVSM capability 

Not equipped: 
- Urgency 

Exempt: 
- Information 

Unknown: 
- Unknown 
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Data field Description Comments Color 

WTC 
and 
/WTC 

Wake turbulence 
category 

“J” for Super, 
“H” for Heavy, 
“M” for Medium, 
“L” for Light 
 
(in /WTC all prefixed with a “/”) 
 
Unselected label: 
Only displayed if not medium 
unless the field is highlighted 

If highlighted: Warning 

WTG 
and 
/WTG 

Wake turbulence group ICAO or RECAT-EU wake 
turbulence group 
 
(in /WTG prefixed with a “/”) 

If highlighted: Warning 

XFL Exit Flight Level See AFL field for number format. 

 
Approach clearance displayed if 
the use of ACF item is not set up. 
 

Unselected label: 
Not shown if equal to CFL/PEL 
and no ongoing coordination. 
 
(DEP list): 
If logged in as CTR and flight not 
inside active sector, displays 
PEL. Otherwise displays XFL. 

Coordination sent: 
- Proposition Out 

Coordination received: 
- Proposition In 

Coordination refused: 
- Warning 

Y No 8.33kHz capability “Y” if aircraft equipment is not 
indicating 8.33kHz capability 

Not equipped: 
- Urgency 

Exempt: 
- Information 

Unknown: 
- Unknown 
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Appendix 2: Color values 
The following table shows the default values for the plugin colors. The Usage column indicates where the 

colors are used (the list may not be complete). In the aircraft colors “Labels” means track labels and any 

lists where aircraft information is displayed, “Tracks” radar position symbols, history dots, prediction lines 

and divergence symbols. 

Color name Default color Usage 

Aircraft colors 

ACF Via CFL  Labels 

AMAN Data Highlight  Labels 

Assumed  Labels, Tracks 

CARD Mark All  Labels 

CARD Mark Own  Labels 

Concerned  Labels, Tracks 

Coordination  Labels, Tracks 

Freq Indicator  Labels 

FSQ SI  Labels 

Info Coord  Labels 

Information  Labels, Windows 

Informed 1  Labels, Tracks 

Informed 2  Labels, Tracks 

Informed 3  Labels, Tracks 

Negotiation In  Labels 

Negotiation Out  Labels 

Oceanic Level Highlight  Labels 

Proposition Accepted  Labels 

Proposition In  Labels 

Proposition Out  Labels 

Redundant  Labels, Tracks 

Reminder  Labels 

Rwy Locked  Labels 

Sid Star Allocation  Labels 

Sid Star No Allocation  Labels 

Suite Highlight  Labels 

TCT Warning  Labels 

Temp Track Highlight  Labels (Find Track function) 

Track Default  Tracks 

Track Highlight  Tracks 

Unconcerned  Labels, Tracks 

Unknown  Labels 

Urgency  Labels, STCA callsign background on plugin windows/lists, Windows 

VFR  Labels, Tracks 

Warning  Labels, Windows 

CPDLC colors 

CPDLC Controller Late  Labels, Windows 

CPDLC Discarded  Windows 

CPDLC DM Request  Labels, Windows 

CPDLC Failed  Labels, Windows 

CPDLC Pilot Late  Labels, Windows 
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Color name Default color Usage 

CPDLC Standby  Labels, Windows 

CPDLC UM Clearance  Labels, Windows 

CPDLC Unable  Labels, Windows 

CPDLC Urgency  Labels, Windows 

Aircraft related items on the radar screen 

AIW intrusion  AIW alert related items 

Conflict Ack FL  Part of flight leg with acknowledged conflict 

Flight Leg  Part of flight leg without MTCD and SAP coverage 

FTD Nominal  FAST separation indicators 

FTD Urgency  FAST separation indicators and labels when overtaken 

GAP Nominal  FAST gap indicators 

GAP Warning  FAST gap indicators when overtaken 

Heading Vector  Heading vector 

Information FL  Part of flight leg with no MTCD or SAP problems 

MQDM  MQDM vector 

Potential FL  Part of flight leg with MTCD potential risk 

QDM  QDM vector 

SEP Tool  Minimum separation tools 8 and greater 

SEP Tool 1  Minimum separation tool 1 

SEP Tool 2  Minimum separation tool 2 

SEP Tool 3  Minimum separation tool 3 

SEP Tool 4  Minimum separation tool 4 

SEP Tool 5  Minimum separation tool 5 

SEP Tool 6  Minimum separation tool 6 

SEP Tool 7  Minimum separation tool 7 

SEP Vert  Extensions of minimum separation tools 

System Calculated TOC  TOC symbol on flight leg 

System Calculated TOD  TOD symbol on flight leg 

TCT Label  TCT leg labels 

TCT Leg  TCT leg part before conflict start 

TCT Leg Embellished  TCT leg from conflict start to CPA 

Urgency FL  Part of flight leg with MTCD or SAP conflict 

Warning FL  Part of flight leg with MTCD or SAP risk 

Map colors 

Active Map  Active TSA map border 

Active Map Type 1  TSA map border/fill 

Active Map Type 2  TSA map border/fill 

Active Map Type 3  TSA map border/fill 

Active Map Type 4  TSA map border/fill 

Active Map Type 5  TSA map border/fill 

Active Map Type 6  TSA map border/fill 

Active Map Type 7  TSA map border/fill 

Active Map Type 8  TSA map border/fill 

Active Map Type 9  TSA map border/fill 

Active Map Type 10  TSA map border/fill 

Active Map Type 11  TSA map border/fill 

Active Map Type 12  TSA map border/fill 

Active Map Type 13  TSA map border/fill 

Active Map Type 14  TSA map border/fill 
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Color name Default color Usage 

Active Map Type 15  TSA map border/fill 

Active Map Type 16  TSA map border/fill 

Active Map Type 17  TSA map border/fill 

Active Map Type 18  TSA map border/fill 

Active Map Type 19  TSA map border/fill 

Active Map Type 20  TSA map border/fill 

Active RD Infill Map  Active R or D map fill 

Active RD Map  Active R or D map border 

Active Text Map  Active TSA map text 

Auto Map Label  Auto-generated maps 

Auto Map Symbol  Auto-generated maps 

East NAT Map  Auto-generated maps, maps 

Map 1  Maps 

Map 2  Maps 

Map 3  Maps 

Map 4  Maps 

Map Hotspot  Map hotspots 

Map Border  Maps 

Map Info  Range rings, range marker 

Map Land  Maps 

Map Symbol  Maps 

Preactive Map  Pre-active map border 

Preactive Text Map  Pre-active map text 

Predisplay Map  Pre-display map border 

Rwy App Line In Use  Runway approach line for runways in use 
Rwy App Line Not In Use  Runway approach line for runways not in use 

TSA Border Highlight  Highlighted TSA map border 

Weather Map  Weather radar data 

West NAT Map  Auto-generated maps, maps 

Window and menu colors 

Active Sector  Predicted Traffic Window and VAW active sector background 

Arm  Inactive window texts 

Background  Background 

Border  Various lines in windows 

BottomShadow  3D effects in windows 

BS Aged  CFL menu Blind Spot function results 

BS Crossed Level  CFL menu Blind Spot function results 

BS No Conflict  CFL menu Blind Spot function results 

BS Unknown  CFL menu Blind Spot function results 

BS Warning  CFL menu Blind Spot function results 

CARD Min Sep  CARD minimum separation area 

CARD Reminder  CARD warning time triangle 

CARD Symbol Fg  CARD conflict numbers 

CARD Time Vector  CARD time vectors 

COL Above Threshold  COL flight bars above warning threshold 

COL Under Threshold  COL flight bars under warning threshold 

Conflict Ack  Acknowledged conflicts in CARD/VAW 

Field Highlight  Selected field 

Flight Highlight  Selected item 
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Color name Default color Usage 

Foreground  Window titles, menu items, active texts, close/min/resize boxes 

Global Menu Highlight  Highlighted items in the Global Menu 

Inactive Sector  CARD, Predicted Traffic Window, SMW and VAW background 

LatLong Info  Coordinate value in Lat/Long Window 

Normal Load  Normal load color 

Overflown  Overflown points in Complete Route Window 

Overload  Overload color 

Potential  Potential conflicts in CARD/VAW 

Select  Selected radio buttons and selection boxes 

Selected  Active filters in Radar menu 

Selected Period  Active areas text in area window 

SMW Highlight  AFL-CFL boxes in SMW (mouse-over) 

SMW Level Band  AFL-CFL boxes in SMW 

SMW Overflight  Overflight lines in SMW 

SMW Overlap  Overlapping AFL-CFL boxes in SMW 

SMW Overlap Box  Multiple same CFL’s box in SMW 

SMW Overshoot  Level bust AFL-CFL boxes in SMW 

TopShadow  3D effects in windows 

Trough  Slider area background 

TSA Active  Active areas background in area window 

TSA Preactive  Pre-active areas background in area window 

VAW Profile  Selected aircraft profile in VAW 

VAW Sector Limits  Sector boundaries in VAW 

VAW Track Position  Selected aircraft position in VAW 

WM Active Fg  Active window title text 

WM Bg  Window title bar background 

WM Border  Window border line 

WM Fg  Window texts 

WM Frame  Window frame when dragging 

Other colors 

Raw Video 1  Raw radar video youngest plots 

Raw Video 2  Raw radar video 

Raw Video 3  Raw radar video 

Raw Video 4  Raw radar video 

Raw Video 5  Raw radar video 

Raw Video 6  Raw radar video 

Raw Video 7  Raw radar video oldest plots 

Standard Line RDF  Direction Finder position circle or direction line 

Text Notes  Text notes 
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